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Welcome

The TekExpress Automotive Ethernet (100BASE-T1) is an automotive Ethernet
compliance test solution for performing electrical characterization of the BroadR-
Reach transmitter as per OPEN Alliance BroadR-Reach (OABR) specification
version 3.2. The IEEE P802.3bw D3.3 (100BASE-T1) specification has a stated
objective to provide electrical interoperability for 100 Mb/s client interface in
reference to the OABR PHY v3.2 specification. BRR and 100BASE-T1 maintain
the same electrical test requirements as it relates to the Physical Medium
Attachment (PMA) transmitter electrical specifications.

BroadR-Reach (100BASE-T1) is an Ethernet-based point-to-point technology for
automotive applications. It provides five test mode signals for electrical
characterization of the Physical Medium Attachment (PMA) sublayer.

DUTID [DUTD01

* Acquire live waveforms Use pre-recorded waveform files

View Compliance | ¥

Acquisitions Version : BroadR-Reach™ (va.2), 100BASE-T1 (IEEE Std 802.3bw™)

Preferences

Figure 1: Setup panel
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Welcome

Supported Tests

Test modes

See also:

vi

m  Transmitter Clock Frequency

m  Transmitter Timing Jitter Master and Slave

m  Transmitter Output Droop

m  Transmitter Power Spectral Density

m  Transmitter Peak Differential Output

m  Transmitter Distortion

m  Return Loss

Table 1: Test modes

Required test mode

BroadR-Reach measurement

1

Transmitter Output Droop

2

Transmitter Timing Jitter
= Transmitter Timing Jitter-Master Jitter

Transmitter Clock Frequency

Transmitter Timing Jitter-Slave Jitter

Transmitter Distortion
Return Loss

= Transmitter Power Spectral Density

= Transmitter Peak Differential Output

Application basics
Install the software
Application directories and usage

File name extensions
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Introduction

Related documentation

The following information is available as part of the TekExpress Automotive
Ethernet documentation set.

Table 2: Related documentation

Item Purpose Location
Help Application operation and User | Application Help menu
Interface help
PDF of the help Printable version of the PDF file that ships with
compiled help TekExpress Automotive
Ethernet software.
Downloadable from http.//
www.tek.com/

Abbreviation and conventions

The online help uses the following conventions:

= When steps require a sequence of selections using the software interface, the
">" delimiter marks each transition between a menu and an option. For
example, File > Save.

= DUT refers to the Device Under Test.
= The terms "waveform" and "signal" are used interchangeably.

®m  The term AWG refers to a Tektronix Arbitrary Waveform Generator.

TekExpress Automotive Ethernet 3.2 Printable Application Help 1
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Introduction

Feedback

Tektronix, Inc.

14200 SW Karl Braun Drive

P.O. Box 500

Beaverton, OR 97077

USA

For product information, sales, service, and technical support:
®  In North America, call 1-800-833-9200.

= Worldwide, visit www.tek.com to find contacts in your area.

Technical support

Tektronix values your feedback on our products. To help us serve you better,
please send us your suggestions, ideas, or comments on your application or
oscilloscope. Contact Tektronix through mail, telephone, or the Web site,
www.tek.com.

When you contact Tektronix Technical Support, please include the following
information (be as specific as possible):

General information = All instrument model numbers
m  Hardware options, if any
= Probes used
®  Your name, company, mailing address, phone number, FAX number

m  Please indicate if you would like to be contacted by Tektronix about your
suggestion or comments.

Application specific = Software version number

information m  Description of the problem such that technical support can duplicate the

problem

m Ifpossible, save the setup files for all the instruments used and the
application.

m Ifpossible, save the TekExpress setup files, log.xml, *.TekX (session files
and folders), and status messages text file.

m Ifpossible, save the waveform on which you are performing the
measurement as a .wfm file.

2 TekExpress Automotive Ethernet 3.2 Printable Application Help
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Operating basics

AWG-AFG automation

AWG\AFG automation is supported in the TekExpress Automotive Ethernet
(100BASE-T1) application for the following measurements. Before selecting the
AWG\AFG automation feature, ensure that a GPIB connection is established
between the oscilloscope and the AWG\AFG. The AFG automation depends on
the measurement used for testing.

m  Transmitter Distortion with disturbing signal: AWG\AFG is used to transmit
a disturbing signal. CH1 and CH1 _inverted are used.

®  Return Loss measurement and calibration: AWG\AFG is used to transmit a
wide band signal. CH1 and CH1 _inverted are used for transmission of the
signal. A marker signal has to be connected to the auxiliary channel of the
oscilloscope (used as trigger source).

How the TekExpress  Automation of the AWG\AFG is taken care in the TekExpress Automotive
Automotive Ethernet ~ Ethernet application in the following way:

Solution automates Qvgg 1. Refresh the Instruments Control Settings to observe the connected AWG

\AFG through GPIB.

| visause USB-0x0899:0x03..

October 25, 2017 07:13:27 lose |

Figure 2: Instrument Control Settings
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Operating basics

2. Once the AWG\AFG is listed as shown above, go to the Global Settings tab

from the Configuration menu of the Tests. If the AWG\AFG is supported, it
will be listed as a drop-down menu option next to the Automate with AWG
\AFG label. By default, the application will consider the connected AWG to
be used for automation.

(+) Compliance Mode | User Defined Mode
Global Settings Calibration
Instruments Detected

| Real Time Scope MS056 ( GPIBS:: 1::INSTR )

Figure 3: Test Selection tab

If you do not want to automate the use of an AWG\AFG, select the Do not
use option in the drop-down menu for that parameter, and then start the
testing.

NOTE. If Automate with AWG\AFG is set as Do not use, you will need to
manually copy the AWG\AF G waveforms from the oscilloscope to the AWG
\AFG. Waveforms are available at C:\Program Files\Tektronix\TekExpress
\TekExpress Automotive-Ethernet\AWG Waveforms.

TekExpress Automotive Ethernet 3.2 Printable Application Help
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Application directories and usage

The application directory and associated files are organized in the folder C:
\Program Files\Tektronix\TekExpress\TekExpress Automotive-Ethernet.

. AWG Waveforms
. Bin

. Compliance Suites
. Examples

, ICP

. Images

. Lib

. Report Generator

| Tools

TekExpress Automotive Ethernet 3.2 Printable Application Help 5



Operating basics

The following table lists the default directory names and their usage.

Table 3: Application directories and usage

Directory names

Usage

InstallDinTekExpress\TekExpress Automotive-
Ethernet

It contains the application and associated files.

TekExpress Automotive-Ethernet AWG
Waveforms

It contains AWG waveforms ( AWG 5K, 7K and
AFG waveforms ) that get used in return loss
and distortion with disturbing signal .

TekExpress Automotive-Ethernet\Bin

It contains miscellaneous TekExpress
Automotive-Ethernet libraries.

TekExpress Automotive-Ethernet\Compliance
Suites

It contains compliance-specific files and filter
files.

TekExpress Automotive-Ethernet

[t contains the Manuals.

TekExpress Automotive-Ethernet\Examples

It contains various support files.

TekExpress Automotive-Ethernet\ICP

It contains instrument and TekExpress
Automotive-Ethernet-specific interface libraries.

TekExpress Automotive-Ethernet\images

It contains images required for the application.

TekExpress Automotive-Ethernet\Lib

It contains utility files specific to the TekExpress
Automotive-Ethernet.

TekExpress Automotive-Ethernet\Report
Generator

It contains style sheets for report generation.

TekExpress Automotive-Ethernet\Tools

It contains instrument and TekExpress
Automotive-Ethernet-specific files.

See Also

View test-related files
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Operating basics

View test-related files

Files related to TekExpress Automotive Ethernet tests are stored in the X:
\Automotive Ethernet\Untitled Session shared folder. In the Automotive Ethernet
folder, each test setup has a test setup file and a test setup folder, both with the
test setup name. The test setup file is preceded by the Automotive Ethernet icon
and usually has no file extension displayed.

Inside the test setup folder is another folder named for the DUT ID used in the
test sessions (the default is DUTO001).

Inside the DUTO0O01 folder are the session folders and files. Each session has a
folder and file pair, both named for the test session using the naming convention
(date) (time). Each session file is stored outside of its matching session folder.

N20110705_033344
20110517 _175249
Vi zo1 10705_033344
Vi 201 10817 _175249

Each session folder contains image files of any plots generated by the test session
and any waveform files if prerecorded waveform files were used during the
session.

The first time you run a new, unsaved session, the session files are stored in the
X:\Automotive Ethernet\Untitled Session folder. Once you name and save the
session, the Untitled Session folder name is changed to the one you specified.

NOTE. By default, test report files are saved in the session folder. You can change
the report file location for a specific test.

See also File name extensions

TekExpress Automotive Ethernet 3.2 Printable Application Help 7



Operating basics

File name extensions

The TekExpress Automotive Ethernet software uses the following file name
extensions:

Table 4: File name extensions

File name extension Description

.TekX Session files are saved in this format but the
extensions may not be displayed

.py The test sequence file

xml The encrypted XML file that contains the test-

specific configuration information
The log file extension is also xml

wfm The test waveform file

.mht Test result reports are saved in this format by

.pdf default. Test reports can also be saved in
MHTML format and .pdf.

.cal Calibration file used with transmitter tests

See also  Application directories and usage
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Getting started

Compatibility

Supported oscilloscopes  The TekExpress Automotive Ethernet application runs on the following
Tektronix oscilloscopes with bandwidths of 1 GHz or greater:

= MSO54, MSO56, MSO58

Supported AWG/AFGs  The TekExpress Automotive Ethernet application supports the following
Tektronix arbitrary waveform and arbitrary function generators:

= AWG7102(Option 2): 10 GS/s
= AWG7122B/C: 12 GS/s

= AWG7082

= AWG7082B/C

= AWG70102

= AWGS5014: 1.2 GS/s, 14-bit AWG
= AWG5014B/C
= AWGS5012B/C
= AWGS5002B/C

»  AFG3252: 2 GS/s, 14-bit AFG
= AFG3252C

= AFG3102: 1 GS/s, 14-bit AFG
= AFG3022B/C

= AFG3052C

= AFG3102C

= AFG3152C

= AFG3102

TekExpress Automotive Ethernet 3.2 Printable Application Help 9



Getting started

NOTE.

m  You may use AWG automation for Return Loss and Transmitter Distortion
with Disturbing Signal measurements.

B AFG3100 & AFG3200 (having limit up to 50 MHz) cannot be used for
Return Loss measurements.

m  Without an amplifier, the AWG7000 series generates a maximum voltage of
2 Volt peak-to-peak signal, which cannot meet the 5.4 Volt requirement for
the disturber signal for Transmitter Distortion test.

Probes  The TekExpress Automotive Ethernet application supports the following
Tektronix differential probes:

= Return Loss Measurement: P6248, P6247, TDP1500
m  All Other measurements: P6247, P6248, P6330, TDP1500, TDP1000

Test fixtures  The TekExpress Automotive Ethernet application supports the TF-GBE-BTP and
TF-BRR-CFD test fixtures.

See also  Minimum system requirements
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Getting started

Minimum system requirements

The following table shows the minimum system requirements for an oscilloscope

to run TekExpress.

Table 5: System requirements

Oscilloscope

For a list of compatible oscilloscopes, see
Compatibility.

Processor

Same as the oscilloscope

Operating System

Same as the oscilloscope

Memory

Same as the oscilloscope

Hard Disk

Same as the oscilloscope

Display

Same as the oscilloscope

Firmware

TekScope 1.4.6 and later (Windows 10, 64-bit
only)

Software

= TekExpress Framework version 4.2.0

= |ron Python 2.7.3

= PyVISA-1.3

= Microsoft .NET 4.0 framework

= Microsoft Internet Explorer 6.0 SP1 or later

= Adobe Reader 8.0 or equivalent software
for viewing portable document format (PDF)
files

Probes

Following differential probes are supported:

= All measurements: P6247, P6248,
P6330,TDP1500, TDP3500. For more
details, refer to the BroadR-Reach
measurements section.

BRR Fixtures

TF-GBE-BTP, TF-BRR-CFD

Other Devices

= Microsoft compatible mouse or compatible
pointing device

= Four USB ports (two USB ports minimum)

= PCI-GPIB or equivalent interface for
instrument connectivity 2

1 If TekExpress is running on an instrument having a video resolution lower than 800 x 600. it is recommended that you connect a secondary monitor,

which must be enabled before launching the application.

2 If TekExpress is installed on a Tektronix oscilloscope, the virtual GPIB port will be used by TekExpress for communicating with oscilloscope
applications. If external GPIB communication devices such as USB-GPIB-HS or equivalent are used for instrument connectivity, ensure that the Talker
Listener utility is enabled in the MSO Oscilloscope's GPIB menu. For ease of use, connect to an external (secondary) monitor.

TekExpress Automotive Ethernet 3.2 Printable Application Help
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Getting started

Frequency Divider The TF-BRR-CFD test fixture allows you to
phase lock frequency between DUT Transmitter
Clock, oscilloscope , and AWG/AFG sources.
Converts DUT Transmitter Clock from
66.666MHz to 10MHz.

Cables Six BNC cables/SMA cables with BNC to SMA
connectors: one TCA-BNC or TCA-SMA.

See also

Compatibility

Install the software

The software can be installed on any compatible instrument running Windows
10.

1. Close all applications (including the TekScope application).

2. Go to the www.tek.com Web site and search for TekExpress Automotive
Ethernet to locate the installation and download the latest installation file.

3. Double-click the executable file to extract the installation files.
After extraction, the installer launches and displays the Install shield Wizard.

4. Follow the prompts to install the TekExpress Automotive Ethernet
application.

The software automatically installs in C:\Program Files\Tektronix
\TekExpress\TekExpress Automotive-Ethernet.

The installer updates the TekScope Application to include TekExpress
Automotive Ethernet.

TekExpress Automot)

Figure 4: TekScope window

See also

12 TekExpress Automotive Ethernet 3.2 Printable Application Help



Getting started

Minimum system requirements

Activate the license
Follow these steps to activate the TekExpress Automotive Ethernet license:

1. From the MSO5X Oscilloscope menu bar, click Help > About.

ABOUT

LIC5-CMAUTOEN ENGINEERING LICENSE - License (installed option); Automotive Ethernet
(100Base-T1) automated compliance test solution; Node locked

none
ENG-DEVL-MSO5X ENGINEERING LICENSE - MSO5X - ENGINEERING DEVELOPMENT LICENSE

Figure 5: About window
2. Click Install License, and then select the .Lic file.

3. Follow the prompts of the oscilloscope to activate the license.

NOTE. Check the Oscilloscope help for the steps to activate the license. Click
F1 key to open the Option Installation topic and follow the steps to activate
the license. Press the F1 key on the oscilloscope keyboard to open the Option
Installation help topic and follow the steps to activate the license.

See also

View version and license information
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Getting started

View version and license information

See also

Start the application

14

Use the following instructions to view application version information and
license information for the application modules.

To view version information:
1. From the Options menu, select About TekExpress.

2. Click the View Version Details link to check the version numbers of the
installed test suites. Close the dialog box when finished.

To view license information:
1. From the oscilloscope Help menu, select About.

The Options section in the dialog box displays a list of installed options,
including TekExpress Automotive Ethernet compliance test solution.

Activate the license

Options menu

To run the TekExpress Automotive Ethernet application from the TekScope
menu, select Application > TekExpress Automotive Ethernet.

File Edit Utility Help

Waveform View TekExpress Automotive Ethernet

A initializing screen is displayed, before the launch of the application.

TekExpress Automotive Ethernet

Initializing . ..

While running the application, you can switch between the oscilloscope screen
and the TekExpress Automotive Ethernet application by clicking the desired
window. To keep the application window on top, select Keep On Top from the
Options menu.

TekExpress Automotive Ethernet 3.2 Printable Application Help
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Options menu

Options menu

TekExpress Automotive Ethernet 3.2 Printable Application Help

NOTE. If the application was not terminated properly during the last use, a dialog
box prompts you to recall the previously unsaved session.

The Options menu is located in the upper right corner of the application.

It has the following selections:

Table 6: Options menu

Menu Function

Default Test Setup It opens an untitled test setup with defaults
selected.

Open Test Setup It opens a saved test setup.

Save Test Setup It saves the current test setup selections.

Save Test Setup As It creates a new test setup based on an existing

one.

Open Recent

It displays a menu of recently opened test
setups to select from.

Instrument Control Settings

It shows the list of instruments connected to the
test setup and allows you to locate and refresh
connections to connected instruments.

Keep On Top It keeps the TekExpress Automotive Ethernet
application on top of other open windows on the
desktop.

Email settings It configures email options for test run and
results notifications.

Help It displays TekExpress Help.

About TekExpress

= ltdisplays application details such as
software name, version number, and
copyright.

= It provides access to license information for
your Automotive Ethernet application
installation.

= It provides a link to the Tektronix Website.

15
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Defaulk Tesk Setup
Cpen Tesk Setup

Sawe Test Setup
Save Test Setup As
Open Recent L4

Instrument Contral Setkings
keep On Top
Email Sektings

Help
About TekExpress

View connected instruments: the instrument control settings

Use the Instrument Control Settings dialog box to view or search for connected
instruments required for the tests. The application uses TekVISA to discover the
connected instruments.

X
_TekExpress Instrument Control Se

| |VISA-GPIB M305204

January 21. 2016 21:43:04 .

Figure 6: Instrument Control Settings
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To refresh the list of connected instruments:
1. From the Options menu, select Instrument Control Setting.

2. Inthe Search Criteria section of the Instrument Control Settings dialog box,
select the connection types of the instruments to search for.

Instrument search is based on the VISA layer but different connected cables
determine the resource type, such as LAN, GPIB, USB. For example, if you
choose LAN, you can search for all the instruments supported by TekExpress
that are communicating over the LAN. If the search does not find any
instruments that match a selected resource type, a message appears telling
you that no such instruments were found. Click OK to close the message
window.

NOTE. Ensure that the GPIB option is enabled to detect the real time
oscilloscope in the Global Settings tab.

3. Click Refresh.
TekExpress searches for connected instruments.

4. After discovery, the dialog box lists the instrument-related details based on
the search criteria you selected. For example, if you selected LAN and GPIB
as the search criteria, the application checks for the availability of
instruments over LAN, then GPIB.

The details of the instruments are displayed in the Retrieved Instruments
table. The time and date of instrument refresh is displayed in the Last
Updated field.
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Application controls

Table 7: Application controls descriptions

Item Description

Options menu It opens the Options menu for access to global
controls.

Panels Visual frames with sets of related options. Some
panels are further divided into tabs and other
sections.

Start button Start

Use the Start button to continuously acquire and
accumulate measurements. If prior acquired
measurements have not been cleared, the new
measurements are added to the existing set.

Stop button %

Use the Stop button to abort a test in progress.

Pause \ Continue button Pause

Use the Pause button to interrupt the current
acquisition. When a test is paused, the button
name changes to Continue.

Clear button Clear

Available only on the Results panel.
Use the Clear button to clear all existing
measurement results.

NOTE. Adding or deleting a measurement, or
changing a configuration parameter of an
existing measurement also clears
measurements. This is to prevent the
accumulation of measurement statistics or sets
of statistics that are not coherent.
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Item

Description

Application window move icon

Place the cursor over the three-dot pattern in
the upper left corner of the application window.
When the cursor changes to a hand, drag the
window to the desired location.

Mini view/ Normal view

=)
=

Toggles the application between Mini view and
Normal view. Mini view displays the run
messages with the time stamp, progress bar,
Start/Stop button, and Pause/Continue button.
The application moves to Mini view when you
click the Start button.

See also

Options menu

Exit the application

Use the following method to exit the application:

NOTE. Using other methods to exit the application results in abnormal

termination of the application.

1.

2. Do one of the following:

Click on the application title bar.

= A message box appears asking if you really want to exit TekExpress. To
exit, click Yes; otherwise, click No.

= [fyou have an unsaved session or test setup open, you are prompted to
save it before exiting. To save it, click Yes. If you do not wish to save,
click No. To remain in the session, click Cancel.

TekExpress Automotive Ethernet 3.2 Printable Application Help
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Application basics

The TekExpress Automotive Ethernet software user interface is intuitive and easy
to use. In addition to the Ul, a programmatic interface is available.

The user interface has four main panels, which allows you do the following:
m  Set up the tests.

®  Prepare to run the tests.

B Run the tests and view the progress of analysis.

m  View the results of the tests.

m  Configure and view reports.

m  Save and recall test setups.

See also  Overview and key specifications
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Setting up tests: the Setup panel

The Setup panel guides you through the Automotive Ethernet test setup process
using tabs. The options selected in a tab affect the options available in the next
tab down.

DUT ID [DUTO01

{ Acquire live waveforms | Use pre-recorded waveform files

View |Compliance | ¥

Version : BroadR-Reach™ (v3.2), 100BASE-T1 (IEEE Std 802.3bw™)

Figure 7: Setup panel

NOTE. A check mark next to a tab title means you have made changes. However,
if you make changes on a tab that significantly affect a prior tab, the check mark
of the affected tab is replaced with its number, indicating that you should check
the settings on that tab.

= DUT tab

Here, you can specify the DUT ID and the view settings. These settings apply
to all tests for the current session, and affect the test list in the Test Selection
tab.

m  Test Selection tab

Here, select tests individually or by group, view a short description of a
selected test, and view a schematic showing appropriate device connections.

B Acquisitions tab
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See also

View configurations for attached probes, view a list of signals and sources,
and view the Acquisitions table.

m  Configuration tab (Displays only when View: Advanced is selected in the
DUT tab.)

Here, select either Compliance Mode or User Defined Mode, view Global
Settings, select measurement settings, and view or edit test parameter limits.

m  Preferences tab

Here, you may specify that an email be sent to you upon test failure.

Saving a test setup
Running the tests and viewing their progress in the Status panel
Viewing test results in the Results panel

Configuring and viewing reports in the Reports panel

Actions on Test Measurement Failure

l_ ‘On Test Failure, stop and notify me of the failure

Figure 8: Preference tab

TekExpress Automotive Ethernet 3.2 Printable Application Help



Setting up tests

Selecting device parameters: the DUT tab

DUTID |DUTO01 | @

[« Acquire live waveforms () Use pre-recorded waveform files

View Compliance | ¥

Version : BroadR-Reach™ (v3.2), 100BASE-T1 (IEEE Std 802.3bw™)

Figure 9: Setup panel

1. Click the DUT tab on the Setup panel and specify the DUT ID and the view
settings.

These settings apply to all current tests, and affect the test list in the Test
Selection tab.

2. Enter the device ID (default value is DUTO001). This ID appears on test

reports. To add comments to the top of a report, click @ and enter up to
256 characters.

3. For the View option, select either Compliance or Advanced.

= [fyou select the Advanced view, an additional Configuration tab
appears.

= To access configuration options for Compliance view, click the
Configure button on the Test Selection tab.

TekExpress Automotive Ethernet 3.2 Printable Application Help 25



Setting up tests

Seealso  Setting up tests: the Setup panel
Choosing tests: the Test Selection tab
Acquiring waveforms: the Acquisitions tab

Configuring tests: the Configure button or Configuration tab

Selecting tests: the Test Selection tab

Use this tab to select the tests to run on the connected DUT. The tests that you
select here impact the parameters available in the Acquisitions tab.

Automotive Ethemet BroadR-Reach/100BASE-T1 Specifications

- Transmit Clock Frequency
=+{w] Transmitter Timing Jitter
~[w] Transmitter Timing Jitter - Master Jitter
Transmitter Timing Jitter - Slave Jitter
3 Transmitter Output Droop
- Transmitter Power Spectral Density
-- Transmitter Peak Differential Output
~[w] Transmitter Distortion
~[~] Return Loss

Test Description

Please select atestname to view its
description

Figure 10: Test Selection tab

To select a test, do the following:
1. In the Setup panel, click the Test Selection tab.
2. Select the desired tests. For a list of supported tests, click here.

= Select the check boxes of individual tests or of entire groups of tests. To
select all tests in the list, click the Select All button and click Deselect
All unless you want to run all tests.

= Click on the Schematic button to display the schematic document for the
selected test. Use to verify the test setup before running the test.

Once you have selected the tests, then you can configure the tests.
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Seealso  Setting up tests: the Setup panel
Acquiring waveforms
Configuring tests. the Configure button or Configuration tab
Running the tests and viewing their progress: the Status panel

Tekironix AWG Tektronix oscilloscope

1

@

To awg |
CH1+.I? J690

To awe _
CH2 - = J190

Figure 11: Example of schematic document
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Selecting acquisitions

Acquiring waveforms: the  The Acquisitions tab in the Setup panel is used to view and set acquisitions
Acquisitions tab ~ parameters for the selected tests. Before you can do this, you must first:

= Select either Acquire Live Waveforms or Use Pre-recorded waveform
files on the DUT tab of the Setup panel.

®m  The acquisition parameters displayed on the Acquisitions tab will differ
depending on your choice on the DUT tab.

If you select Acquire Live Waveforms on the DUT tab, do the following:

1. In the Setup panel, click the Acquisitions tab.

ouT Automotive Ethernet BroadR-Reach/100BASE-T1 Specifications

Probe1 Probe2
CH1 v| [cH2 v

(Soices)

TestName Acquisition

» Transmit Clock Frequency Transmit Clock Frequency Acquisition
Transmitter Timing Jitter - Master Jitter Transmitter Timing Jitter - Master Jitter /
Transmitter Timing Jitter - Slave Jitter  Transmitter Timing Jitter - Slave Jitter Ac
Transmitter Output Droop Transmitter Output Droop Acquisition
Transmitter Power Speciral Density Transmitter Power Spectral Density Acq
Transmitter Peak Differential Qutput ~ Transmitter Peak Differential Output Acc
Transmitter Distortion Transmitter Distortion Acquisition
Return Loss Return Loss Acquisition

Acquisition and Save Options

All waveforms are saved before analysis I show e

[ Acquire Step By Step
Signal Validation

Promptme if signal f. .. v

Refwfms: C:\U5ers\PublidTek‘Ironi)(\TekAupIicaﬁons\Automoﬁve-Ethe‘

Figure 12: Acquisitions tab with Acquire live waveforms selected

2. Select the probe source channel for each listed signal in the Probe selection
drop-down menu.

3. You may select to view the probe configuration for each channel used.

4. You will see the Acquisitions table. For information about the possible
parameter columns displayed in the Acquisitions table, click here.

The following table below lists the possible parameter columns displayed in the
Acquisitions table in the Acquisitions tab of the Setup panel. Columns displayed
depend on the tests selected in the Test Selection tab, and whether or not the
Show Acquire Parameters check box has been selected.
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Table 8: Acquisitions parameters

Column name

Function

Test Name

Displays the name of the
selected test for performing
acquisitions. One or more tests
can perform the same
acquisitions.

Acquisition

Displays the named acquisition.

Record Length

Displays the size of the record in
samples.

Disturbing signal

Displays whether or not a
disturbing signal is excluded.

Average

Displays the number of averages
that will be used with average
mode acquisition.

AWG Series

Displays the AWG series model,
if present.

TX_TCLK

Displays whether or not a
TX_TCLK is excluded.

Hi resolution

Displays the HiRes(Vertical
resolution) factor.

WaveForm FileName

Displays the name and location
of the waveform file to be used
for the measurement. Applies
only to testing using prerecorded
waveforms.

5. Underneath the table, you may select the Show Acquire Parameters check
box. When selected, the acquisition parameters for each test displays an

additional columns in the Acquisitions table.

TekExpress Automotive Ethernet 3.2 Printable Application Help
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You may select the Acquire Step by Step check box. When selected, the
application prompts you to continue after each phase of test completes.

Select a Signal validation parameter (Signal validation is valid only for Live
acquisitions):

= Prompt me if signal fails: Select to prompt if signal fails.

Signal ¥alidation

Use Amanvay Skip Test Reacquire

= Use Anyway: Click to Run the test on the current acquired signal in
spite of failed signal.

= Skip Test: Click to skip the current test after signal validation fails.
= Reacquire: Click to reacquire the signal for the test being Run.

= Use signal as is-Don't check: Select to perform the test without signal
validation.

= Skip test if signal fails:Select to skip the test for which signal validation
fails.
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1. In the Setup panel, click the Acquisitions tab.

ouT Automotive Ethemet BroadR-Reach/100BASE-T1 Specifications

(Souces)

Record Length  Average No of Acquisiti.. ExternalRefCl.. TX_TI
» .05
h10
€10
o

o
i
L

Software Signal C Excluc

<] —— a

Acquisition and Save Options
[\7 Show Acquire Parameters

Refwims: C:Wsers\Public\TektronixXTekApplications\Automotive-Ethe

Figure 13: Acquisitions tab with Use pre-recorded waveform files selected

nt

2. You will see the Acquisitions table. Locate the row for the desired test and

then click the ellipsis button (a) in the Waveform FileName column. Select
a file. You can select more than one file for each test. For information about
the possible parameter columns displayed in the Acquisitions table, click
here.

3. Underneath the Acquisitions table, you may select the Show Acquire
Parameters check box. When selected, the acquisition parameters for each
test are displayed in additional columns in the Acquisitions table.

The following table below lists the possible parameter columns displayed in the
Acquisitions table in the Acquisitions tab of the Setup panel. Columns displayed
depend on the tests selected in the Test Selection tab, and whether or not the
Show Acquire Parameters check box has been selected.
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Acquire live waveforms for
analysis

32

Table 9: Acquisitions parameters

Column name

Function

Test Name

It displays the name of the
selected test for performing
acquisitions. One or more tests
can perform the same
acquisitions.

Acquisition

It updates the location of the
named acquisition.

Record Length

It displays the size of the record
in samples.

Disturbing signal

It displays whether or not a
disturbing signal is excluded.

Average

It displays the record average.

AWG Series

It displays the AWG series
model, if present.

TX_TCLK

It displays whether or not a
TX_TCLK is excluded.

Hi resolution

It displays the resolution.

WaveForm FileName

It displays the name and location
of the waveform file to be used
for the measurement. Applies
only to testing using prerecorded
waveforms.

See also. Use pre-recorded waveforms for analysis

Acquire live waveforms for analysis

Setting up tests the Setup panel

Use these instructions to set up acquisition for a live waveform.

1. Open a saved test setup or create a new one.

2. In the Setup panel, select the DUT tab, enter the desired DUT ID, and then

select the Acquire live waveforms check box.
3. Select other DUT options as desired.
4. In the Test Selection tab, select the desired test(s).

5. Inthe Acquisitions tab, select or view the desired parameters in the

Acquisitions Table.

6. Configure the tests if you have not done so already, and then click Start to

run the test.

See also. Acquiring waveforms the Acquisitions tab

Use pre-recorded waveforms for analysis
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Use pre-recorded  You can use pre-recorded waveforms for analysis.
waveforms for analysis

NOTE. If you are using the pre-recorded waveform files option, it is
recommended that you use a waveform file (wfm) that was captured from a
Tektronix oscilloscope. This eliminates the need to use an oscilloscope. You can
manually select waveforms and perform the tests by clicking the Start button. The
reference waveforms are provided with the installer at C:\Users\Public\Tektronix
\TekApplications\TekExpress Automotive-Ethernet.

Use Transmitter Distortion_6p25GSa_RL1p5SM.wfm while performing
Transmitter Distortion test in pre-recorded mode; do not consider other
Transmitter Distortion waveforms.

1. Open a saved test setup or create a new one.

2. In the Setup panel, select the DUT tab, select the desired DUT, and then
select Use pre-recorded waveform files check box.

3. Inthe Test Selection tab, select the desired tests.

4. Inthe Acquisitions tab, locate the row for the desired test in the Acquisitions
Table, and then In the Waveform FileName column for that test, click the

ellipses button (&) and select the desired waveform file.

5. Perform any additional desired test setup, such as test configuration, and then
click Start to run the test.

You can select a different waveform file for each test, clear a test from the
current run, or add a test to the current run. Once you click Start, data
corresponding to that test run populates the other panels (such as the test status
and test results).

See also. Acquiring waveforms the Acquisitions tab

Acquire live waveforms for analysis

Acquire step by step  The Acquire Step By Step option is available in the Acquisitions panel. This is a
global parameter that is applied to all tests when selected. By default, this option
is deselected.

When selected, this parameter allows for display of the reference input waveform
of the selected measurement. This helps to compare the input waveform coming
from DUT with the typical reference waveform (snap shot), allowing you to
change the setup before acquiring the waveforms. The following table gives
different reference waveform snap shots that appear for different tests.

NOTE. When using prerecorded waveform files, the Acquire Step By Step option
is not available.
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Table 10: Reference waveforms

Test name Reference waveform

Transmit Timing Jitter — Master Jitter

Transmit Timing Jitter — Slave Jitter

Transmitter Output Droop

Transmit Clock Frequency
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Test name

Reference waveform

Transmitter Distortion

Transmitter Power Spectral Density

Transmitter Peak Differential Output

Return Loss

TekExpress Automotive Ethernet 3.2 Printable Application Help
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Configuring tests: the Configuration screen

Once you’ve selected tests, you may use the Configuration screen. There are two
ways to reach the screen: the Configuration tab or the Configure button.

Automotive Ethemet BroadR-Reach/100BASE-T1 Specifications

' Transmit Clock Frequency
=[] Transmitter Timing Jitter
Transmitter Timing Jitter - Master Jitter
~[w] Transmitter Timing Jitter - Slave Jitter
Transmitter Output Droop
Transmitier Power Speciral Density
5 Transmitter Peak Differential Output
~[#] Transmitter Distortion
..[7] Return Loss

Test Description
Please select a testname to view its
description

Figure 14: Configure button on Test Selection tab
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- Test ~TLimits ™
'+ Compliance Mode | User Defined Mode - -
Global Settings Calibration

- Transmit Clock Frequency
(=) Transmitter Timing Jitter
Transmitter Timing Jitter - Master Jitter
Transmitter Timing Jitter - Slave Jitter
. Transmitter Output Droop
- Transmitter Power Spectral Density
Transmitter Peak Differential Qutput
Transmitter Distortion
. Retum Loss

External Ref Clock Input
() Hardware Clock Divider

() Software Signal Correction

) None

Figure 15: Configuration tab

The TekExpress Automotive Ethernet solution you are using determines how you
may reach the Configuration screen.

m  Ifyou selected Compliance View in the Setup panel of DUT tab, click the
Test Selection tab and select the desired test. Then click the Configure
button in the lower right corner of the Test Selection tab.

= [fyou selected Advanced View in the Setup panel of DUT tab, the
Configuration tab will appear on the Setup panel — click on it.

The Configuration screen shows Global parameters, which are common for all
tests, and Measurement parameters, which are specific to selected tests, including
acquisition, analysis, and limit parameters.

NOTE. Test parameters that are grayed cannot be changed.
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Settings

See also

m  Compliance Mode or User Defined Mode
= Global Settings tab

In the Instruments Detected section, click in the shaded area opposite Real Time
Scope and select the desired instrument from the drop-down list. If you don’t see
the instrument, refresh the list by using the Instrument Control Settings.

m  Measurements tab

Lists all tests for the selected measurement type. Click on a measurement to view
the available parameters in the tabbed filed below the list. The parameters and
parameter type tabs shown depend on the selected test. To edit the test
parameters, select the User Defined Mode check box.

®  You may change test parameters. Select the test whose parameters you would
like to change. The options below the test list change to reflect the selected
test.

To modify the parameters, select the desired tab and parameters. For
parameter details, see Measurement Parameter Descriptions.

' Compare String  LowLimit Compare String  High Limit |
Transmit Clock Frequency Transmit Clock Freq... > Greater Than 66.663326... <LessThan 66.66999333
Transmitter Timing Jitter - Mast... Transmitter Timing ... N.A N.A <=lessThanOrE... 50
Transmitter Timing Jitter - Slave... Transmitter Timing ... N.A N.A <=LessThan OrE...

Transmitter Output Droop Transmitter Output ... N.A N.A <=LessThan Or E...
Transmitter Power Spectral Den... Transmitter Power ... N.A N.A <=LessThan Or E...
Transmitter Distortion Transmitter Distorti... N.A N.A <=LlessThan OrE...
Return Loss Return Loss (ps) N.A N.A <=LessThan Or E...

Figure 16: Limits Editor

m  Use the Limits Editor button in the upper right corner to view or change the
High Limit and Low Limit values used for each measurement.

Next, prepare to run the tests.

Setting up tests: the Setup panel

Selecting device parameters: the DUT tab
Choosing tests: the Test Selection tab
Acquiring waveforms: the Acquisitions tab

About saving and recalling test setups
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Compliance mode or User defined mode

From the Configuration screen, you will have the option to select either
Compliance Mode or User Defined Mode.

= Compliance Mode: Select to use Compliance Mode values. You cannot
change most test parameters in Compliance Mode, but you can view the
compliance parameters.

= User Defined Mode: Select to run tests using custom parameters. You may
change parameters that are not grayed out.

NOTE. These modes are not to be confused with the two views available from the
DUT tab:Compliance View and Advanced View.

Pairing modes and views  Your selections of Modes and Views will change the way the tests operate. These
for test operation  pairings of views and modes are possible:

= Compliance View selected with Compliance Mode: Tests will run
automatically with little or no user intervention. You will not be able to
change test parameters to anything that deviates from the compliance
standards. To view configuration options, click the Test Selection tab of the
Setup panel, and then click the Configure button.

= Compliance View selected with User Defined Mode: Tests will run
automatically but you will be able to change test parameters before starting
the tests. To view configuration options, click the Test Selection tab of the
Setup panel, and then click the Configure button.

®  Advanced View selected with Compliance Mode: Tests will run
automatically with little or no user intervention. You will not be able to
change test parameters to anything that deviates from the compliance
standards. To view configuration options, click the Configuration tab of the
Setup panel.

m  Advanced View selected with User Defined Mode: Tests will run
automatically but you will be able to change test parameters before starting
the tests. To view configuration options, click the Configuration tab of the
Setup panel.
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Measurement parameter descriptions
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View or change measurement parameters in the Configuration tab of the Setup
panel. Measurement parameters are displayed for the test selected in the tree view
section. Not all of the parameters listed apply to all tests, and some are only
available when running tests in User Defined Mode. You cannot change most
parameters if you selected Compliance Mode.

'+ Compliance Mode | User Defined Mode

Global Settings Calibration

- Transmit Clock Frequency
(= Transmitter Timing Jiter
Transmitter Timing Jitter - Master Jitter
Transmitter Timing Jitter - Slave Jitter
. Transmitter Output Droop
- Transmitter Power Spectral Density

Transmitter Peak Differential Output
Transmitter Distortion
- Retum Loss

External Ref Clock Input
() Hardware Clock Divider

"+ Software Signal Correction

) None

Figure 17: Measurements tab

Table 11: Measurement parameters

Name Unit Range/Allowable | Description Applies to
values
Record Length M 11020 Sets the record | Transmit Clock
length to use. Frequency
Transmitter Timing
Jitter (Master
Jitter)
Transmitter Timing
Jitter (Slave Jitter)
Averages NA 2t0 100 Sets the number | Transmitter Output
2 to 256 of averages Droop
210512 (number of Transmitter Power
acquisitions) for | Spectral Density
average mode Return Loss
acquisition.
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Name Unit Range/Allowable | Description Applies to
values
Hardware Clock | NA NA Select to use the | Transmitter
Divider external hardware | Distortion
clock divider unit
(66.66 MHz
Tx_CLK to
10 MHz) to
synchronize the
DUT, disturber
signal source
(AWG/AFG), and
the oscilloscope.
Software Signal | NA NA Select to use the | Transmitter
Correction internal software | Distortion
signal correction to
synchronize the
DUT, disturber
signal source
(AFG/AWG), and
the oscilloscope.
None NA NA Select to check | Transmitter
the behavior of the| Distortion
DUT without any
Ref clock (External
or Internal).
Edge Used to select the | Transmitter Timing
. type of edges on | Jitter (Master
= Falling which RMS jitter | Jitter)
= Rising will be calculated. | Transmitter Timing
Jitter (Slave Jitter)
Hysteresis % 1t0 10 Sets the Transmitter Timing
hysteresis in Jitter (Master
percentage that | Jitter)
gets used during | Transmitter Timing
edge finding. Jitter (Slave Jitter)
RBW KHz 110100 Sets the resolution| Transmitter Power
bandwidth. This | Spectral Density
controls the
bandwidth of the
spectral analyzer
filters.
Center Frequency | MHz 110 500 Sets the center of | Transmitter Power

the frequency
span over which
spectral analysis is

done.

Spectral Density

TekExpress Automotive Ethernet 3.2 Printable Application Help
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Name Unit Range/Allowable | Description Applies to
values
Frequency Span | MHz 110500 Sets the range of | Transmitter Power

frequencies over | Spectral Density
which spectral
analysis is done

Smooth NA 0to10 Sets the number | Return Loss
of samples that
will be used while
smoothing the
return loss
waveform; sets the
averaging filter
length.

See also  Configuring tests: the Configure button or Configuration tab

Calibration

Calibration can be performed on live waveforms or by using the already-
calibrated waveforms.

Measurements
Following are the measurements which can be calibrated:
Transmitter Distortion

In Transmitter distortion, calibration is done to effectively remove the disturbing
signal and compensate for non-linearity in the disturber and test fixture.
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'+ Compliance Mode | User Defined Mode

Global Settings Calibration

Disturber Compensation
10f3: comodnmawwcmmsim TC5@P19

g -

M A1IMHZ 11.114MHz.

Test fidure Compensation
20f3: mmmﬂhmmmemm

“""—I a
Test fixture Compensation
3«1c«mmmwmmmgmsmumm
O S ——

Pfobe Point Amplit... FREEN]
Attenuation

Figure 18: Calibration tab

Return Loss

m  Live calibration

— Toast
) Compliance Mode |+ User Defined Mode - ﬁ
Global Settings Calibration

[« Live Calibration | Use Pre-Recorded Files

ProbeP1@TC1  ProbeP2@TC1  Synchinput
[CH1 |v ]| [cH2 | ¥ | [CH3 ||

CalStatus  CalTime

Complete  Jan 142016 a
compiete  Janta20ts ()

Jan 142016 é
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e~
{+) Compliance Mode | User Defined Mode - “
Global Settings Calibration

() Live Calibration | Use Pre-Recorded Files

ProbePI@TC1  ProbeP2@TC1  SynchInput
ICH1 |v | [cH2 | v | CH3 | v |
CH1
CalTime |CH2 |

CH3
Jan 142016 |CH4
CH5
Jan 14 2016 |CHB
CH7

Jan 14 2016

Figure 19: Live calibration

NOTE. The live Calibration files are saved in X:\Automotive Ethernet\Calibration
folder.

Use pre-recorded files
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* Compliance Mode

User Defined Mode “ @
(e
P e ] | 2 ) Test Selection -

Select Calibration Files Directory

| X\Automotive EthemefCalibration | G

Al calibration files (Short/Load/Open) should be
available in the selected directory. These files will
be copied to the default calibration folder.

Figure 20: Use pre-recorded files

Table 12: Calibration table parameters

Parameter

Description

Live Calibration

Sets the live calibration process.

Use Pre-recorded Calibration

Sets the calibration process with prerecorded
calibrated waveforms and allows you to browse
and select the calibrated waveforms. The path
for selecting the calibrated waveforms is C:
\Users\Public\Tektronix\TekApplications
\Automotive-Ethernet.

Channel drop down

Allows you to select relevant channel and
probes.

NOTE. when you change the input sources
(Channel) other than calibrated sources, you
need to re-calibrate with latest sources.

Cal Type

Displays the type of calibration: Load, Open, and
Short.

Cal Status

Displays the status of the calibration: Pending,
Done.

Cal Time

Displays the previous calibration time: Date,
Month, and Year .

Schematic button

Click to view the schematic.

Plot button

Click to view the plot.
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Parameter Description

Apply button Click to apply the configured parameters to
calibration.

Run button Click to run the process of calibration.

Default button Click to perform calibration by using default

values.

NOTE. This button is applicable only for
Transmitter distortion. The expected and
measured values for Transmitter distortion on
Calibration tab will be initially empty, when you
launch the application for the first time and they
get populated once you click the Default button .

To manually set up signal source: Click here and
copy files to USB drive and recall on connected
signal source.

In case of manual signal source (AFG/AWG)
setup, click the link and copy the relevant folder
and recall the setup on connected signal source.

Synch Input

As there is no auxiliary channel on the MSO5X
series oscilloscope, Synch Input channel is
provided. It takes input from the marker of the
AWG or TTL output of AFG.
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Before you click start

Before running a test for the first time
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Before you run a test for the first time, review these steps:
1. Understand where your test files are stored on the instrument.

After you install and launch TekExpress Automotive Ethernet, it creates the
following folders on the oscilloscope:

®  \Program Files\Tektronix\TekExpress\TekExpress Automotive-Ethernet
= \Documents\My TekExpress\Automotive Ethernet
= \Documents\My TekExpress\Automotive Ethernet\Untitled Session

Every time you launch TekExpress Automotive Ethernet.exe, an Untitled
Session folder is created in the Automotive Ethernet folder. The Untitled
Session folder is automatically deleted when you exit the TekExpress
Automotive Ethernet application.

CAUTION. Do not modify any of the session files or folders because this may
result in loss of data or corrupted session files. Each session has multiple files
associated with it. When you save a session, a .TekX file, and a folder named for
the session that contains the associated files, is created on the oscilloscope X:
drive.

2. Ensure that the My TekExpress folder has read and write access, and that
the contents are not set to be encrypted:

Right-click the folder and select Properties.
b. Select the General tab, and then click Advanced.
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c. Inthe Advanced Attributes dialog box, ensure that the option Encrypt
contents to secure data is NOT selected.

Example:

M TekExpress Properties ? @

General | Sharing || ‘Web Sharing | Customize |

Advanced Attributes

Choose the setbings you want For this Falder

Wehen vou apply these changes you will be asked if you want the
changes to affect all subfolders and Files as well.

| by TekExpress

?]X]

archive and Index attribukes

[ ] Falder is ready For archiving

Far Fast searching, allow Indexing Service to index this Falder

Compress of Encrypt attributes

i_ompress contents bo save disk space;

[]Efcrypt contents ko secure data Details

[ ok ] [ Cancel

()4 ][ Cancel ] Apply

Figure 21: Advanced Attributes dialog box

Before running any test
1. Review the Pre-run check list.

2. Configure the Email notification options if you want the application to notify
you by email when a test completes or produces an error. Access the email
options either from the Options menu in the upper right corner, or from the
Preferences tab on the Setup panel.

3. Select the Report options.
See also

Pre-run check list
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Pre-run check list

Do the following before you click Start to run a test. If this is the first time you
are running a test on a setup, then refer also to the guidelines above.

1. Ensure that all the required instruments are properly warmed up (about
20 minutes).

1

Perform the Signal Path Compensation (SPC).
On the oscilloscope main menu, select the Utilities menu.

Select Instrument Calibration.

Deskew any cables.

A » ¥ @

Ensure that the application is able to find the DUT. If it cannot, perform a
search for connected instruments.

To find the DUT:
Launch the TekExpress Automotive Ethernet application.
b. Select the Setup panel and then click the DUT tab.

c. Click the Test Selection tab. Select any test, and then click Configure
button.

d. In the Configuration section, click Global Settings.

e. In the Instruments Detected section, click in the shaded area opposite Real
Time Scope and ensure that the oscilloscope with the (GPIB8::1::INSTR)
designation is in the drop-down list.

See also  Before you click start
Configure email notification

Running the tests and viewing their progress
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Configure email notification

Set up these email settings if you want the application to notify you by email
when a test completes or produces an error. Configure email from the Options
menu.

1. From the Options menu in the upper right corner, select Email Settings to
open the Email settings dialog box, or click the Preferences tab on the Setup
panel.

Figure 22: Email Settings dialog box

2. (Required) For Recipient email Address(es), enter your email address. You
can include multiple addresses as long as you separate the addresses with
commas.

3. (Required) For Sender's Address, enter the email address used by the
instrument. This address consists of the instrument name, followed by an
underscore, followed by the instrument serial number, the @ symbol, and the
email server used. For example: DPO72004C_B130099@yourcompany.com.

4. (Required) In the Server Configuration section, type the SMTP Server
address of the Mail server configured at the client location, and the SMTP
Port number, in the corresponding fields.

If this server requires password authentication, enter a valid login name,
password, and host name in the corresponding fields.

NOTE. If any of the above required fields are left blank, the settings will not
be saved and email notifications will not be sent.

5. In the Email Attachments section, select from the following options:

= Reports: Select to receive the test report with the notification email.
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m  Status Log: Select to receive the test status log with the notification
email. If you select this option, then also select whether you want to
receive the full log or just the last 20 lines.

NOTE. The ScoreCard and Analysis Screenshot options are not available.

6. Inthe Email Configuration section, select as desired:

= Enter a maximum file size for the email message. Messages with
attachments larger than this limit will not be sent. The default is 5 MB.

= To limit the number of attempts the system makes to send a notification,
enter the number in the Number of Attempts to send field. The default is
1. You can also specify a timeout.

7. Select the Email Test Results when complete or on error check box. Use
this check box to quickly enable or disable email notifications.

8. To test your email settings, click Test Email.
9. To apply your settings, click Apply button.
10. Click Close button to exit the Email Settings dialog box.

See also  Before you click start
Pre-run check list

Running the tests and viewing their progress

Running the tests and viewing their progress: the Status panel

Once you have configured the tests and gone through the Pre-run check list, from
any screen, click the green Start button. The application acquires and analyzes
the data, then displays a report when the tests are completed.

While the tests are running, other applications may display windows in the
background. The TekScope application takes precedence over other applications,
but you can switch to other applications using the Alt+Tab key combination. To
keep the TekExpress Automotive Ethernet application on top, select the Keep On
Top from the Options menu in the upper right corner.
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Viewing the progress of  The Status panel displays a record of the test as it is executed. By default, the
analysis  application switches to this panel after you click the Start button to run a test.
You can choose from the following two views by selecting the named tab, even
while a test is in progress:

Test Status view

The Test Status tab presents a collapsible table with information about each test
as it is running. To collapse and expand the table rows, click the expand (E)/(=)
collapse button.

Table 13: Status tab table

Column Description

Test Name Name of the test

Acquisition Describes the type of data being acquired
Acquire Status Progress of the acquisition:

= To be started
= Started Acquisition

= Completed Acquisition

Analysis Status Progress state of the analysis:
= Tobe started

= InProgress

= Completed
= Aborted
= Skipped

Log View

The Log View tab provides a list of actions that happen as the test executes. You
can use this tab to review or troubleshoot tests.

Table 14: Log view options

Item Description

Message History This window time-stamps and displays all run
messages.

Auto Scroll Select this check box to have the program

automatically scroll down as information is
added to the log during test execution.

Clear Log Click this button to clear all messages in the
Message History area.

Save Use to save the log file as a text file for
examination. Displays a standard Save File
window and saves the status messages file that
you specify.
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See also  Before you click start
Pre-run check list

Configure email notification
Test Status tab

Transmit Clock Frequency Transmit Clock Freguency Acquisition To be started
Transmitter Timing Jitter - Master Jitter Transmitter Timing Jitter - Master Jitter Acquisition To be started
Transmitter Timing Jiter - Slave Jitter Transmitter Timing Jitter - Slave Jiter Acquisition To be started
Transmitter Output Droop Transmitter Output Droop Acquisition To be started
Transmitter Power Spectral Density Transmitter Power Spectral Density Acguisition To be started
Transmitter Peak Differential Output Transmitter Peak Differential Output Acquisition To be started
Transmitter Distortion Transmitter Distortion Acquisition To be started
Return Loss Return Loss Acquisition To be started

Acquisition

Figure 23: Test status tab
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Log View tab

Initializing run time environment. This might take some time.
10/25/17 08:42:18 : Scope Address: GPIB8::1:INSTR
i 8 : Scope Model: MSO56
- IDN Val: TEKTRONIX,MSO56,PQ300120.CF.91.1CT FV:1.4.5.3765
: FimWare Version:1.4.5.3765
: Selected Tests are: [Transmit Clock Frequency]
: Started Execution: Transmit Clock Frequency
: Scope Reset completed.
: Scope Autoset Started...
: Scope Autoset Completed.
:26 - Trigger Setting completed.
- Set Sample Rate: 10.0GHz
26 : Record Length : 500.0K samples
: Horizontal Settings completed.
: Vettical Scale set to: 147.0mV
- Vertical Offset set to: 3.76171875mV
: Scope Temination Impedance set to 50 Ohms.
: After Applying Band Limiting Filter on Math1
: Watting for Single Sequence Trigger..
: Acquisttion Completed for Tx Clock Fi
- Signal Validation Started...
: Signal Validation Passed.
: Time Taken by Clock Frequency Algo: 0:00:01
10/25/17 08:42:54 - Exited Algorithm
Populating results for Template Transmit Clock Frequency

Figure 24: Log view
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Viewing plots
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The Plots panel displays a summary of plot generated during run. The plots have
zoom, cursors, save, dock/undock, and select test features.

Types of Plots

Following are different plots generated during run, based on the measurement(s)
selected.

= Transmit Clock Frequency

Figure 25: Transmit Clock Frequency
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= Transmitter Timing Jitter

Master Jitter

|Seleciimest] Transmitter Timing Jitter - Master... | ¥

Transmitter Timing Jitter(Master)

40p -
2.58E0R)

TIE (sec)

-40p:

-80p -
-IZOpE
-160p -
3200 480u  640u  800u

v T I
-320u -160u (1] 160u

200p 3 s v b
-800u -640u -480u

Time (sec)

Figure 26: Master Jitter

Slave Jitter
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Figure 27: Slave Plot
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= Transmitter Output Droop
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Figure 28: Transmitter Output Droop
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= Transmitter Power Spectral Density
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Figure 29: Transmitter Power Spectral Density
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®  Transmitter Distortion

Error value
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Figure 30: Error Value

Peak Distortion
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Figure 31: Peak Distortion
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Return Loss

.. TekExpress Automotive Ethernet - (Untitled)* )
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Figure 32: Return Loss

Return Loss Load

LOAD Calibratrion result

Return Loss (dB)

Figure 33: Return Loss Load

Return Loss Short
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SHORT Calibratrion result
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Figure 34: Return Loss Short

Return Loss Open

OPEN Calibratrion result

Return Loss (dB)

Figure 35: Return Loss Open

See also  Known limitations
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Viewing test results: the Results panel

When a test completes running, the application switches to the Results Panel.

Set result viewing preferences from the Preferences menu in the upper right
corner.

Each test result occupies a row in the Results table. By default, results are
displayed in summary format, with the measurement details collapsed, and with
the Pass/Fail column visible. You can change the display view.

= To expand all test rows listed, from the Preferences menu in the upper right
corner, select View Results Details.

= To expand a collapsed test row, click the plus button () ) to the left of the
test row.

= To collapse all expanded test rows, select Preferences > View Results
Summary.

To collapse a single expanded test row, click the minus button (&) to the left
of the test row.

m  To remove or restore the Pass/Fail column, select Preferences > Show Pass/
Fail.

= To enable or disable the wordwrap feature, select Preferences > Enable
Wordwrap.

= To expand the width of a column, place the cursor over the vertical line that
separates the column from the one to the right. When the cursor changes to a
double-ended arrow, hold down the mouse button and drag the column to the
desired width.

= To sort the test information by column, click the column head. When sorted
in ascending order, a small up arrow is displayed. When sorted in descending
order, a small down arrow is displayed.

] Clear

To clear all test results displayed, click Clear® button.
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Seealso  Setting up tests the Setup panel
Configuring and viewing reports: the Reports panel
Running the tests and viewing their progress: the Status panel

Results Preferences

Transmll Clock Transmit Clock (% Pass 66.668
3 Frequancy Fregquency
Transmitter Timing Transmitter

(%) Jitter - Master Jitter Timing Jitter-  {§ Pass
Master Jitter

Transmitter Timing Transmitter
) Jitter - Slave Jitter Timing Jitter- (@ Pass
Slave Jitter
Transmitter Output Transmitter 37.0357
(= Droop Output Droop: (4 Pass
Positive Droop
Transmitter Qutput Transmitter 36.0932
(#) Droop Output Droop: & Pass
Negative
Transmitter Power Transmitter
) Spectral Density Power Spectral & Pass
Density
Transmitter Peak Transmitter
@ Differential Output Peak
Differential
Output
2 Transmitter Distortion  Transmitter
Distortion

&P Pass

& Pass

[# Return Loss Return Loss & Pass

Figure 36: Results preferences
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Configuring and viewing reports: the Reports panel

Use the Report panel to browse for name, and save reports, select report viewing
options, and to view reports.

n 000

C:\Images'\Logo gif !

R:\Auiumot'rve Ethemet\Reports\DUT001
Web Archive (*.mht;” mhtml) n

%
%
%
v
v
%
%

Figure 37: Reports panel

Naming a report

Use the Reports Panel to select the naming convention to use for the report. By
default, the test report file is located in the session folder to which it belongs, and
gets overwritten each time you run the test under the same device name if you
don’t change the test report name before running the test.

If you do not want your test results to be overwritten each time you run any test,
always give the report a unique name, or select to have the name increment each
time you run a particular test. Generally, you would select report options before
running a test, or when creating and saving test setups. Report settings are
included in saved test setups.

Selecting report options

= Report name
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Displays the default name and location where the report will be saved when
generated.

To change the report name or location, type over the current folder path and name
and then save the test setup. Be sure to include the entire folder path, the file
name, and the file type. For example: C:\Documents and Settings\your user name
\Documents\My TekExpress\Automotive Ethernet\DUT001 groupl.mht.

To open an existing report, click Browse button, locate the report file and then
click View button.

NOTE. You cannot change the file location using the Browse button.

m  Save as type

Saves a report in a file type different from the default. Lists supported file types
to choose from (Web Archive (*mht,*mhtm), PDF (*pdf) ), CSV (*csv) ).

NOTE.
m  The CSV file will open Excel, if available. Otherwise, it will open in Notepad.

®m  [fyou select a file type different from the default, be sure to change the report
file name extension in the Report Name field to match.

= Auto increment report name if duplicate

If the application finds a report with the same name as the one being generated,
the application automatically increments the name of the report. For example:
DUTO001, DUT002, DUT003

®  Include user comments

Select to include any comments about the test that you or another user added in
the DUT tab of the Setup panel. Comments appear in the Comments section
under the summary box at the beginning of each report.

= Append reports

This option adds new report data to the end of an existing report of the same
name. This option is deselected by default.

= View report after generating

Automatically opens the report in your Web browser when the test completes.
This option is selected by default.

NOTE. If you unchecked this option before running a test but now would like to
view the report, then when analysis is complete, click the Browse button at the
top of the Reports panel and navigate to the report file.

Viewing a report
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See Also

You can view any report by locating and opening the report file, which ends
in .mht unless you changed the file type before running the report.

NOTE. The application automatically zooms the test report on the scope along
with waveform details, after completion of test.

The top of the report displays information about the instruments and probes used,
the duration of the test, software versions, and some summary test information.
Below that is a table that shows the test name, measurement details, various
measurements, test result (pass/fail), Compliance Mode status (Yes/No), and
analysis time. Additional test parameter information that does not fall into the
other columns is put in the Comments column.

Report example

TekExpress Automotive—Ethernet

Transmitter Test Report

Teltronix:

Setup

DUT ID DUT001 TekExpress Automotive-Ethernet 1.1.0.40

Pre-Recorded Mode True FrameWork Version 4.2.10.38

Compliance Mode Yes Scope Model MSO56

Date/Time 2017-10-25 04:57:11 FirmWare Version 1.4.5.3765

Overall Execution Time 0:00:26

Overall Analysis Time 0:00:03

Overall Test Result Pass

DUT COMMENT: General Comment - BroadR-Reach DUT

Test Name Summary Table

Transmit Clock Frequency Pass

Transmit Clock Frequency

Measurement Details| Measured Value Unit Test Result Margin Low Limit High Limit
Iinn:ymlt Clock Freq 66.668 MHz B IE -0.0077, H: 0.005 66.6603 66.6736
COMMENTS | Number of unit Intervals - 50000

Back to Summary Table

Figure 38: Report example

Setting up tests: the Setup panel
Running the tests and viewing their progress: the Status panel
Viewing test results: the Results panel

About saving and recalling test setups
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About saving and recalling test setups

TekExpress Automotive Ethernet opens with the default test setup selected. Any
time you want to create a new test setup, you can select the default test setup to
clear the previous test setup selections and take the settings back to their defaults.

You can run a test before or after saving a setup. When you save a setup, the
selected oscilloscope, general parameters, acquisition parameters, measurement
limits, prerecorded waveform files (if applicable), test, and other configuration
settings are all saved under the setup name. You can open a setup and click Start
button without having to do any other setting up except ensuring that the
oscilloscope is detected and ready. For details, see Before you click start.

Seealso  Save a test setup
Recall a saved test setup
Create a new test setup based on an existing one
Delete a test setup

Setting up tests: the Setup panel

TekExpress Automotive Ethernet 3.2 Printable Application Help 71



Saving and recalling test setups

Saving a test setup

See also

Save a test setup before or after running a test using the parameters you want
saved. You can create a new setup from any setup you have open or from the
default setup. When you select the default test setup, all parameters are returned
to their defaults. The following instructions start from the default setup:

1. From the Options menu, select Default Test Setup.
2. Select the desired options in the Setup panel.

3. Select the desired report options.
4

If desired, run the test to ensure that it captures the information you want. If it
does not, edit the parameters.

n

From the Options menu, select Save Test Setup.

6. Name the test and, then click Save button.

About test setups
Recall a saved test setup
Create a new test setup based on an existing one

Delete a test setup

Recalling a saved test setup

72

These instructions are for recalling saved test setups.
1. From the Options menu, select Open Test Setup.

2. In the File Open dialog box, select the desired setup from the list, and then
click Open button.

See also

About test setups

Save a test setup

Create a new test setup based on an existing one

Delete a test setup
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Creating a new test setup based on an existing one

Use this method to create a variation on a test setup without having to create the
setup from the beginning.

1. From the Options menu, select Open Test Setup.

2. In the File Open dialog box, select the desired setup from the list, and then
click Open.

3. Modify the parameters as desired.

4. From the Options menu, select Save Test Setup As.

5. Inthe File Save As dialog box, enter a test setup name, and then click Save.
See also

About test setups

Save a test setup

Recall a saved test setup

Delete a test setup

Deleting a test setup

If you no longer need a test setup, delete it from the test setup list in the Options
menu using these instructions.

Each saved test setup consists of two main parts, the test setup file and the test
setup folder, both named for the test session.

1. Ensure the setup you want to delete is not currently selected in TekExpress
Automotive Ethernet.

2. Navigate to the Automotive Ethernet folder where test setup files are stored.
For example, X:\Automotive Ethernet\(test setup name).

3. Locate the test setup file, and then delete it.
This removes the setup from the list in the Options menu.

4. Locate the test setup folder. If you want to keep any of the session files,
move them out of the test setup folder and then delete the test setup folder.

See also

About test setups

Save a test setup

Recall a saved test setup

Create a new test setup based on an existing one
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BroadR-Reach measurements

Transmitter Clock Frequency

Test setup for Transmitter
Clock Frequency

Specification = BroadR-Reach Physical Layer Transceiver Specification for Automotive
Applications, version 3.2, section 5.1.3 or IEEE P802d3bwTM (100 BASE
T1) section 96.5.4.5 transmitter specifications

m  BroadR-Reach Physical Media Attachment Test Suite version 2.0, section
5.5

Required test equipment  In addition to the DUT and oscilloscope, you will need the following:
= One supported differential probe.
= Short RJ45 connector
m  Test fixture: TF-GBE-BTP

Test setup procedure for ~ The Transmitter Clock Frequency measurement setup involves the DUT, test
Transmitter Clock  fixture, and the oscilloscope.
Frequency

Connect the equipment as shown in connection diagram and as explained in the
following procedure.

1. Set the DUT to generate and transmit test mode 1 signal.

2. Connect the Ethernet cable to J490 and the test port of the DUT.

If the DUT does not have an RJ45 connector, then strip the RJ45 cable on
one side and solder it to the appropriate pins on the DUT.

3. Connect the differential probe to P9 and the configured channel of the
oscilloscope.
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Test setup procedure DUT Tektronix oscilloscope

Figure 39: Connection diagram for Test setup procedure for Transmitter Clock Frequency,
Transmitter Timing Jitter-Master Jitter, Transmitter Timing Jitter-Slave Jitter, Transmittter
Output Droop, and Transmitter Power Spectral Density

NOTE.

Ensure that the "+" on the probe tip aligns with "<" on the text fixture board.
This takes care of the polarity being not reversed.

Measurement setup and  Table 15: Measurement setup and algorithm

algorithm
Item Requirements
Configuration parameters 1. Record Length
Signal type Test mode 2
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Item

Requirements

Measurement algorithm outputs

1. Clock frequency
2. Number of unit intervals

Measurement algorithm inputs

Test mode 2 signal captured in differential form

Limits

Lower limit: 66.6603 MHz
Upper limit: 66.6736 MHz

Plots

Plot showing only 4 cycles of clock frequency

Measurement algorithm  TekExpress Automotive-Ethernet solution automatically executes the
calculations described below for the Transmit Clock Frequency measurement.

1. Check if the input waveform pattern is a test mode 2 or not. The test mode
2 signal is a clock signal where the PHY shall transmit the data symbol
sequence (+1, -1) repeatedly on all channels.

2. Compute and verify the clock frequency between the High and Low limits as

mentioned in the above table.

Seealso  Plots

Transmitter Timing Jitter Master and Slave

This test confirms that the transmitter timing jitter of the PMA is within

conformance limits.

Test setup for (Master
Jitter)

Specification = BroadR-Reach Physical Layer Transceiver Specification for Automotive
Applications, version 3.2, section 5.4.3 or IEEE P802d3bwTM (100 BASE
T1) section 96.5.4.3 transmitter specifications

m  BroadR-Reach Physical Media Attachment Test Suite version 2.0, section

53
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Required test equipment

Test setup procedure for
Timing Jitter (Master) test

Test setup (Slave Jitter)

Specifications

Required test equipment

Test setup procedure for

78

Timing Jitter (Slave) test

In addition to the DUT and oscilloscope, you will need the following:
m  One supported differential probe.

m  Short RJ45 connector

m  Test Fixture: TF-GBE-BTP

The Timing Jitter (Master) measurement setup involves the DUT, test fixture,
and the oscilloscope.

Connect the equipment as shown in this connection diagram (refer to Figure 40)
and as explained in the following procedure:

1. Set the DUT to generate and transmit a test mode 2 signal.

2. Connect the Ethernet cable to J490 and the test port of the DUT. If the DUT
does not have a RJ45 connector, then strip the RJ45 cable on one side and
solder it to the appropriate pins on the DUT.

3. Connect the differential probe to P9 and the configured channel of the
oscilloscope.

= BroadR-Reach Physical Layer Transceiver Specification for Automotive
Applications, version 3.2, section 5.4.3 or IEEE P802d3bwTM (100 BASE
T1) section 96.5.4 transmitter specifications

= BroadR-Reach Physical Media Attachment Test Suite version 2.0, section
53

In addition to the DUT and oscilloscope, you will need the following:
m  One supported differential probe

m  Short RJ45 connector

m  Test fixture: TF-GBE-BTP

m  Link partner (This is needed to put the DUT to slave mode.)

The Timing Jitter (Slave) measurement setup involves the DUT, test fixture, link
partner, and oscilloscope.

Connect the equipment as shown in this connection diagram and as explained in
the following procedure:

1. Set the DUT to operate in normal mode.

2. Connect the DUT to the link partner and establish a normal Ethernet
connection.
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3. Use the appropriate cable or probe to bring the DUT TX TCLK to the
configured channel of the oscilloscope.

NOTE. You will need to choose either an SMA cable, a BNC cable, or a
differential probe based on the interface available on the DUT for
TX TCIK. .

Slave transmitter timing jitter can only performed when the DUTs TX TCLK
is exposed and accessible.

Test setup procedure DUT Tektronix oscilloscope

Doog [el=lv]v]

Test fixture (TF-GBE)

Figure 40: Connection diagram for Transmitter Clock Frequency, Transmitter Timing Jitter-
Master Jitter, Transmitter Timing Jitter-Slave Jitter, Transmittter Output Droop, and
Transmitter Power Spectral Density

NOTE. Ensure that the "+" on the probe tip aligns with "<" on the text fixture
board. This takes care of the polarity being not reversed.
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Timing Jitter (Slave) test Tektronix Oscilloscope

Link Partner

Figure 41: Connection diagram for Timing Jitter (Slave) test
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Measurement setup and  Table 16: Measurement setup and algorithm

algorithm

Item

Requirements

Configuration parameters

a. Hysteresis
b. Edge Type

Signal type

Test mode 2 (master) and TK_TCLK (slave)

Measurement algorithm outputs

MASTER

RMS TIE between test mode 2 waveform and unjittered
reference

SLAVE

RMS TIE between TX_TCLK waveform and unjittered
reference
Number of edges considered for computation

Measurement algorithm inputs

MASTER

Minimum 1 ms duration test mode 2 signal captured in
differential form.

Hysteresis

Edge Type

SLAVE

Minimum 1 ms duration TX_TCLK signal captured in
differential form.

Hysteresis

Edge Type

Limits

MASTER

Lower limit; NA
Upper limit: 50 ps

SLAVE

Lower limit: NA
Upper limit: 150 ps

Plots

Time trend of TIE
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82

Measurement algorithm
(Master)

Measurement algorithm
(Slave)

TekExpress Automotive-Ethernet solution automatically executes the
calculations as described below:

1.

Edge locations in test mode 2 waveform (captured in differential form) are
determined with middle level percentage as 50%. Hysteresis and EdgeType
are entered by user in GUI.

The least square method is used for straight line fit, with Y as the edge
locations and X as the edge indices. Only edges that match the EdgeType
entered by the user in the GUI are considered for fitting. Slope and intercept
are determined as the output of the least square method. Using the intercept
and slope, reconstructed edge locations are determined (un-jittered
reference).

reconstructedTime(I) = intercept + I * slope, [ = 0 to num_edges(num_edges
depend on EdgeType)

Compute TIE on EdgeType entered by user in GUIL.

TIE(I) = reconstructedTime(I) — EdgePosition(I), I = 0 to
num_edges(num_edges depend on EdgeType).

Compute rms value of TIE, which is reported as the result.

TekExpress Automotive-Ethernet solution automatically executes the
calculations as described below:

1.

Edge locations in TX TCLK waveform (captured in differential form) are
determined with middle level percentage as 50%. Hysteresis and EdgeType
are entered by user in GUI.

The least square method is used for straight line fit, with Y as the edge
locations and X as the edge indices. Only edges that match the EdgeType
entered by the user in the GUI are considered for fitting. Slope and intercept
are determined as the output of the least square method. Using the intercept
and slope, reconstructed edge locations are determined (un-jittered
reference).

reconstructedTime(I) = intercept + I * slope, [ = 0 to num_edges(num_edges
depend on EdgeType).

Compute TIE on EdgeType entered by user in GUIL.

TIE(I) = reconstructedTime(I) — EdgePosition(I), I = 0 to
num_edges(num_edges depend on EdgeType).

Compute rms value of TIE, which is reported as the result.
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See also  Plots

Transmitter Power Spectral Density

This test confirms that the transmitter power spectral density is within
conformance limits.

Test setup for Power
Spectral Density

Specification = BroadR-Reach Physical Layer Transceiver Specification for Automotive
Applications, version 3.2, section 5.4.4 or IEEE P802d3bwTM (100 BASE
T1) section 96.5.4.4 transmitter specifications

= BroadR-Reach Physical Media Attachment Test Suite version 2.0, section
5.4

Required test equipment  In addition to the DUT and oscilloscope, you will need the following:
m  One supported differential probe
m  Short RJ45 connector
m  Test fixture: TF-GBE-BTP

Test setup procedure for  The Power Spectral Density test involves the DUT, test fixture, and the
Power Spectral Density  oscilloscope.
test

Connect the equipment as shown in this connection diagram and as explained in
the following procedure:

1. Set the DUT to generate and transmit test mode 5 signal.

2. Connect the Ethernet cable to J490 and the test port of the DUT.

If the DUT does not have an RJ45 connector, then strip the RJ45 cable on
one side and solder it to the appropriate pins on the DUT.

3. Connect the differential probe to P9 and the configured channel of the
oscilloscope.

4. Ensure that the "+" point of differential probe should be near [>.
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Power Spectral Density DuT Tektronix oscilloscope

Lo w]v) wl=lw]v]

Test fixture (TF-GBE)

Figure 42: Connection diagram for Power Spectral Density

NOTE. Ensure that the "+" on the probe tip aligns with "<" on the text fixture
board. This takes care of the polarity being not reversed.

Power spectrum curve  Table 17: Power spectrum curve mask information
mask information

Frequency PSD Upper Bound (dBm) | PSD Lower Bound (dBm)
at 1 MHz -23.3 -30.9
at 20 MHz -24.8 -35.8
at 40 MHz -28.5 -40.2
57 MHz - 200 MHz -36.5 -NA

Upper and lower limits/masks are piece-wise linear masks connecting points
given in the above table.
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Transmitter Power Spectral Density Mask

Settings. RBW = 10 KHz, VBW = 30 KHz, sweep time > 1 min, RMS detector,
sweep time 3.275 seconds

Measurement algorithm  TekExpress Automotive-Ethernet solution automatically executes the
calculations as described below for the power spectral density measurement.

1. The test mode 5 signal feed as input is filtered using a band limiting filter
with cut off frequency of 600 MHz.

2. Spectral functions (SpectralMag) present in the oscilloscope MATH sub
system are used for computing the spectrum of the filtered test mode 5 signal.

3. The output of “SpectralMag” is averaged over “Averages” times. “Averages”
is an acquisition parameter present in the GUI. The default value of this
parameter is 64.

4. ”SpectralMag” is executed with the following configuration settings:
= Center frequency: 100.5 MHz
= Frequency span: 201 MHz
®  Window type: Gaussian
m Vertical axis: scale —> Linear
m  Gating duration: 200 micro seconds
®  QGating duration = Record length * sampling rate
m  Mega samples / 12.5 GS/sec = 200 micro seconds
= Gating position: 0
= R =100 0Ohm
Averaged SpectralMag is saved and used in postprocessing.

6. In postprocessing, the averaged spectral output is filtered using a moving
average filter (smoothing).

7. Filtered result is X(k). From X(k), we compute the power in dBm as given
below.
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Power = (V_rms”"2)/R

Power in frequency domain = |X(k)|*2/R where k = 0 to N-1 are frequency
bins

Power in dB = 20*log10(|X(k)|) — 10*log10(R)
Power in dBm = Power in dB + 10*1og10(1000)
Power in dBm = Power in dB + 10*1og10(1000)
20*log10(|X(k)|) — 10*log10(R) + 10*1og10(1000)
If R =100 Ohm,

Power in dBm = 20*log10(|X(k)|) — 20 + 30
Power in dBm = 20*log10(|X(k)|) — (20 - 30)
Power in dBm = 20*log10(|X(k)|) — Offset

Where Offset = (20 — 30)

8. Computed power in dBm is compared with limits given in the specification,
which gives limits only at certain frequencies. Linear interpolation is used to
find values for intermediate frequencies.

Seealso  Plots

Transmitter Peak Differential Output

This test confirms that the transmitter peak differential output is within 2.2 V
peak-to-peak limits.

Test setup for Transmitter
Peak Differential Output

Specification

IEEE Draft P802.3bw/ D3.3 (100 BASE T1) section 96.5.6 transmitter
specifications

m  BroadR-Reach Physical Media Attachment Test Suite version 1.0, section
5.8
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Required test equipment

Test setup procedure for
Transmitter Peak
Differential Output test

Peak Differential Output

In addition to the DUT and oscilloscope, you will need the following:
m  One supported differential probe

m  Short RJ45 connector

m  Test fixture: TF-GBE-BTP

The Transmitter Peak Differential Output test involves the DUT, test fixture, and
the oscilloscope.

Connect the equipment as shown in this connection diagram and as explained in
the following procedure:

1. Set the DUT to generate and transmit test mode 5 signal.

2. Connect the DUT Ethernet cable to J490 port of the TC2 segment of the test
fixture.

If the DUT does not have the RJ45 connector, then strip the RJ45 cable on
one side and solder it to the appropriate pins on the DUT.

3. Connect the differential probe to P9 and the configured channel of the
oscilloscope.

4. Ensure that the "+" point of differential probe should be near |>.

DuT Tektronix oscilloscope

v lw[w]v) wl=lw]v]

Test fixture (TF-GBE)

Figure 43: Connection diagram for Peak Differential Output

TekExpress Automotive Ethernet 3.2 Printable Application Help 87



BroadR-Reach measurements

NOTE. Ensure that the "+" on the probe tip aligns with "<" on the text fixture
board. This takes care of the polarity being not reversed.

Measurement algorithm  TekExpress Automotive Ethernet solution automatically executes the calculations
as described below for the Transmittter Peak Differential Output measurement.

1. This measurement uses the test mode 5 signal for Peak Differential Output
measurement.

2. Measurement acquires multiple test signals, which are defined on the
Configuration tab. You can modify the values in the User Define Mode.

3. This test uses the Histogram peak-to-peak measurement to compute the peak-
to-peak value. The histogram is being built over the defined number of
acquisitions and compute the results.

Figure 44: Peak Differential Output
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Transmitter Output Droop

This test confirms that the transmitter output level does not decay faster than the
maximum specified rate.

Test setup for Transmitter
Output Droop

Specification = BroadR-Reach Physical Layer Transceiver Specification for Automotive
Applications, version 3.2, section 5.4.1 or [IEEE P802d3bwTM (100 BASE
T1) section 96.5.4.1 transmitter specifications

m  BroadR-Reach Physical Media Attachment Test Suite version 2.0, section
5.1

Required test equipment  In addition to the DUT and oscilloscope, you will need the following:
m  One supported differential probe
= Short RJ45 connector
m  Test fixture: TF-GBE-BTP

Test setup procedure for ~ The Transmitter Output Droop measurement setup involves the DUT, test fixture,
Transmitter Output Droop  and the oscilloscope.

Connect the equipment as shown in this connection diagram and as explained in
the following procedure.

1. Set the DUT to generate and transmit test mode 1 signal.

2. Connect the Ethernet cable to J490 and the test port of the DUT. If the DUT
does not have an RJ45 connector, then strip the RJ45 cable on one side and
solder it to the appropriate pins on the DUT.

3. Connect the differential probe to P9 and the configured channel of the
oscilloscope.
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Measurement setup and  Table 18: Measurement setup and algorithm

algorithm
Item Requirements
Configuration parameters 1. Averages
Signal type Test mode 1
Droop = 100x(Va/Vix ) %

Measurement algorithm outputs 1. Positive Droop in %

2. Number of positive droops

3. Negative Droop in %

4. Number of negative droops
Measurement algorithm inputs Test mode 1 signal captured in differential form
Limits Lower limit: NA

Upper limit: 45%

Transmitter Output Droop DUT Tektronix oscilloscope

o fo e | e | o valow | )

Test fixture (TF-GBE)

Figure 45: Connection diagram for Transmitter output droop
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Measurement algorithm  TekExpress Automotive Ethernet solution executes the calculations described as
below for the transmitter output droop measurement.

1. Check if the input waveform pattern is a square wave test pattern or not.

2. Ifitis square wave test pattern, then check whether positive and negative
widths are greater than 33 unit intervals (500 nS).

3. On each rising edge, compute the maximum voltage (Vj, positive) and compute
the voltage (Varoop positive) 00 ns after that maximum voltage index.

Vq= (Vp _positive — Vdroop _positive)
Positive Droop = (V¢/V} positive) * 100

4. On each falling edge, compute the minimum voltage (Vj, negative) and
compute the voltage (Vgroop_negative) 500 ns after that minimum voltage
index. -

Vq= (Vp_negative - Vdroop_negative)
Negative Droop = (V¢/V}, negative) * 100

See also  Plots

Transmitter Distortion

This test confirms that the peak transmitter distortion is less than 15 mV for all
10 Uls within the eye opening.

Test setup for Transmitter
Distortion

Specification = BroadR-Reach Physical Layer Transceiver Specification for Automotive
Applications, version 3.2, section 5.4.2 or IEEE P802d3bwTM (100 BASE
T1) section 96.5.4.2 transmitter specifications

m  BroadR-Reach Physical Media Attachment Test Suite version 2.0, section
52
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Required test equipment

Test setup procedure for
Transmitter Distortion

92

In addition to the DUT and the oscilloscope, you will need the following:

NOTE. You will need to complete the calibrate procedure before doing the
Transmitter Distortion measurement with disturbing signal. The calibrate
procedure is used to effectively remove the disturbing signal and compensate for
nonlinearity in the disturber and test fixture.

m  One supported differential probe

m  Two BNC cables (for connecting AFG or AWGS5K to fixture) or two SMA
cables with two BNC to SMA connectors (for connecting AWG7K to fixture)

m  Short RJ45 connector

= GPIB cable (required if you use AWG automation, connects AWG and
oscilloscope)

m Test fixtures: TF-GBE-BTP

m  TF-BRR-CFD (Clock Frequency Divider Unit): This is used to synchronize
oscilloscope and signal source with the DUT Transmit CLK.

NOTE. If you are using R&S Clock divider fixture, then the output from the
R&S fixture must be terminated with 50 ohms, which goes to oscilloscope as
external REF Clock input.

Connect the equipment as shown in the below connection diagram.

This measurement is divided into the following two parts. Do them in this order:
1. Calibration
2. Measurement with disturbing signal

Calibration is used to effectively remove the disturbing signal and compensate
for nonlinearity in the disturber and test fixture. Calibration is used only when
measurements are executed with a disturbing signal.

Design of the transmitter to tolerate the presence of the remotely driven signal
with acceptable distortion or other changes in performance is a critical issue and
must be addressed by the implementer. A disturbing signal is used to simulate the
presence of a remote transmitter. The disturbing signal is defined as a sine wave
generator that simulates the potential interfering effect of another transmitter.

BroadR-Reach (100BASE T1) measurements that require test mode 4 have to be
done with a disturbing signal. Characteristics of disturbing signal are given in the
following table.

Table 19: Characteristics of disturbing signal

Test mode Waveform Characteristics of the waveform Purity
Amplitude (p-p) | Frequency (MHz)
4 Sinusoidal 54V 11111 All harmonics >
40 dB below
fundamental
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Disturber compensation  As part of calibration following compensations are done:

Disturber Compensation
1 of 3 Connect Tektronix AWG/AFG to test fixture TCS @ P19

Test Parameter Expected Value Measured Value
Frequency 11.111MHz 11.111MHzZ

Figure 46: Disturber compensation

Disturbing signal is fed from AWG/AFG. As part of disturbing signal
compensation, do the following:

1. Measure peak amplitude and frequency of disturbing signal.

2. Calibrate/adjust the AWG so that measured amplitude and frequency are as
close as possible to default/expected values as mentioned in the above table.

3. Use the final measured amplitude and frequency values as initial values for
disturbing signal removal.

A. Disturbing signal == )
compensation (AWG/AFG) i [

o ||| REF CK Input

Ext REF CK N
Input

TxCK —™

cooo | T
_ ToMmHz
66.667 MHz — —
b,

e ' Clock Divider Unit |

ToAWG
CH1+ 1690

CHZ- = J790

To DUT

0881.013

Figure 47: Disturbing signal compensation (AWG)
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NOTE.

m  Clock Divider Unit is not used during Disturber signal compensation.
Application will setup the reference clock input to internal.

m  Without an amplifier, the AWG7000 series generates a maximum voltage of
2 Volt peak-to-peak signal, which cannot meet the 5.4 Volt requirement for
the disturber signal for Transmitter Distortion test.

m  Ensure that the "+" on the probe tip aligns with "<" on the text fixture board.
This takes care of the polarity being not reversed.

DISturbIng SIQnaI Tektronix AFG 3
compensation (AFG) Jewe(y]| - Tekironix oscloscope

U &= [EXUREF CK N
= Input

TXCK —™

—
66.667 MHzL — —_J

o Clock Divider Unit

TCS

T

-

ToAFG
CH1+am 690

CH2- = J790

J700

Figure 48: Disturbing signal compensation (AFG)

Connection diagram for disturbing signal compensation (part of calibration)
Make the connection as shown above:

1. Connect a BNC Cable to (AWG/AFG)"+" and Channel 1 of Arbitrary
Waveform Generator/Arbitrary Function Generator to J690.

2. Connect a BNC Cable to (AWG/AFG)"-" and Channel 2 (CH1 _inverted) of
Arbitrary Waveform Generator/Arbitrary Function Generator to J790.

Short the jumpers J621, J630, J623, J721, J723, J680,and J781.

Connect the Differential Probe to P19 and configured channel of the
oscilloscope.
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5. Under the Calibration tab, select the Run button in the Disturber
Compensation grid.

6. If the Measured Value is not approximately equal to the Expected Value,
modify the amplitude and clock frequency settings of the Arbitrary
Waveform Generator/Arbitrary Function Generator; then, click Measure and
compare the values to be approximately equal.

7. Select the Run button to compensate for disturber signal to meet expected
values of 5.4 Vpp and 11.111 MHz

NOTE.

m  Set the attenuator factor to 10X on the probe, if you are using P6247\6248.
This is applicable for Disturbing Signal Compensation, Test Fixture
Compensation and Measuring amplitude sections.

m  Ensure that the "+" on the probe tip aligns with "<" on the text fixture board.
This takes care of the polarity being not reversed.

m At the calibration level, application uses the internal reference clock.

Tektronix AFG N\
ik: i Tektronix oscilloscope

REF CK Input

= [ExtREF CK N
‘;;. Input

TXCK —™

l 10 MHz
66.667 MHz — —/

Ea Clock Divider Unit ‘ )

TCS
ToAFG

CH1+@ J690

CH2- = J790

Figure 48: Disturbing signal compensation (AFG)

Connection diagram for disturbing signal compensation (part of calibration)
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Make the connection as shown above:

1.

Connect a BNC Cable to (AWG/AFG)"+" and Channel 1 of Arbitrary
Waveform Generator/Arbitrary Function Generator to J690.

Connect a BNC Cable to (AWG/AFG)"-" and Channel 2 (CHI1 _inverted) of
Arbitrary Waveform Generator/Arbitrary Function Generator to J790.

Short the jumpers J621, J630, J623, J721, J723, J680,and J781.

Connect the Differential Probe to P19 and configured channel of the
oscilloscope.

Under the Calibration tab, select the Run button in the Disturber
Compensation grid.

If the Measured Value is not approximately equal to the Expected Value,
modify the amplitude and clock frequency settings of the Arbitrary
Waveform Generator/Arbitrary Function Generator; then, click Measure and
compare the values to be approximately equal.

Select the Run button to compensate for disturber signal to meet expected
values of 5.4 Vppand 11.111 MHz

NOTE.

Set the attenuator factor to 10X on the probe, if you are using P6247\6248.
This is applicable for Disturbing Signal Compensation, Test Fixture
Compensation and Measuring amplitude sections.

Ensure that the "+" on the probe tip aligns with "<" on the text fixture board.
This takes care of the polarity being not reversed.

At the calibration level, application uses the internal reference clock.
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Disturbing signal Tokironix AFG )
Compensatlon (AFG) AER ~ i Tektronix oscilloscope o

E,: 222.2888 REF CK Input

5‘ Input

CH1 CH2

'

TXCK —

10 MHz
66.667 MHZL —  J

= Clock Divider Unit |

TCS
ToAFG

CH1+a J690

CH2- ‘= J790

Figure 48: Disturbing signal compensation (AFG)

Connection diagram for disturbing signal compensation (part of calibration)
Make the connection as shown above:

1. Connect a BNC Cable to (AWG/AFG)"+" and Channel 1 of Arbitrary
Waveform Generator/Arbitrary Function Generator to J690.

2. Connect a BNC Cable to (AWG/AFG)"-" and Channel 2 (CH1_inverted) of
Arbitrary Waveform Generator/Arbitrary Function Generator to J790.

Short the jumpers J621, J630, J623, J721, J723, J680,and J781.

4. Connect the Differential Probe to P19 and configured channel of the
oscilloscope.

5. Under the Calibration tab, select the Run button in the Disturber
Compensation grid.

6. If the Measured Value is not approximately equal to the Expected Value,
modify the amplitude and clock frequency settings of the Arbitrary
Waveform Generator/Arbitrary Function Generator; then, click Measure and
compare the values to be approximately equal.

7. Select the Run button to compensate for disturber signal to meet expected
values of 5.4 Vpp and 11.111 MHz
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NOTE.

m  Set the attenuator factor to 10X on the probe, if you are using P6247\6248.
This is applicable for Disturbing Signal Compensation, Test Fixture
Compensation and Measuring amplitude sections.

m  Ensure that the "+" on the probe tip aligns with "<" on the text fixture board.
This takes care of the polarity being not reversed.

m At the calibration level, application uses the internal reference clock.

Text fixture compensation Test fiture Compensation

2 of 3: Connect DUT to test fidure TC2 @ P9 without disturber signal
Test Parameter Expected Value Measured Value @

Figure 49: Text fixture compensation -P9

Test fixture Compensation
3 of 3: Connect DUT to test fixture TCS @ P18 without disturber signal

Test Parameter Expected Value Measured Value
Attenuation 15 15

Figure 50: Text fixture compensation -P18

1. Measure the peak amplitude of the signal which is acquired when both DUT
signal (test mode 4) and disturbing signal are ON. Let this peak amplitude be
Ampl (Refer, B- Test Fixture Compensation diagram).

2. Measure the peak amplitude of the signal which is acquired when only DUT
signal (test mode 4) is ON and disturbing signal is OFF. Let this be Amp?2.
An attenuation factor Ampl/Amp2 is computed. This is used as attenuation
compensation factor.

AFG configuration

The AFG setup happens automatically when you click the Run button at
Step-1 of Disturber Compensation on Calibration tab and also sets the Signal
Generator on Global Settings tab.

Following parameters are set for AFG:
1. Resets the AFG.

2. Sets amplitude to 5.4 Vpp.

3. Sets frequency to 11.111 MHz.

4. Sets the external Ref clock.

5. Turns on CH1 and CH2.
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Calibration compensation
connection diagram (AFG/
AWG)

Point 1, 2, and 3 are applicable for both CH1 and CH2 and the phase set to CH1
is 0 degrees and for CH2, it is 180 degrees. Fore more details, refer to connection

Diagram B (Test Fixture Compensation) and C (Measuring amplitude with
disturbing signal OFF and DUT signal ON).

NOTE.

m  Ensure that before clicking the Start button the calibration steps are
performed.

®  During calibration, the signal source AFG/AWG will be setup automatically

from the application by loading the disturber pattern.

m  When you click the Start button, the AFG/AWG does not setup, only
oscilloscope will setup because the application will not disturb the
calibration done using AFG/AWG.

The application automatically controls the AWG 5K and 7K similarly to that of

AFG as described above.

B. Test fixture compensation

: To AWG/AFG
L J >
i7 Clock Divider Unit i:

Tektronix oscilloscope

66.667 MHz

T DuT

‘ [wiw]w]w) el =w|w]

Test fixture (TF-GBE)

J490

0881015

Figure 51: Connection diagram for Test fixture compensation
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Measuring amplitude with DUT signal ON

Connection diagram for Test fixture compensation (DUT signal)
Make the connections as shown above:

1. Set the DUT to generate Test Mode 4 signal.

2. Connect the Ethernet cable to J490 and the test port of the DUT.

3. Connect the Differential Probe to P9 and configured channel of the
oscilloscope.

4. In the Calibration tab, select Run button in Step-2 in the Test Fixture
Compensation pane.

NOTE. Ensure "+" on the probe tip aligns with " < " on the text fixture board.
This takes care of the polarity being not reversed.

C. Measuring amplitude )
with disturbing signa| OFF Tfklronix AWG ’ L~ Tekironix oscilloscope
and DUT signal ON (AWG/ ; ) || REF CK Input T —

AFG) s

Input

TxCK —

10 MHz

: -
Clock Divider Unit '7 /
TC5 —

66.667 MHz

To AWG

CH1+/@  y6o0 A

cHz. .m0 [

Figure 52: Connection diagram for measuring amplitude with disturbing signal OFF and DUT
signal ON -AWG
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CH1+d J690

CH2- = J790

Tektronix AFG )
‘ o|=eses () - Tektronix oscilloscope

i Ext REF CK A
Input

TxCK —™

j‘q =]
10 MHz

Ry

Clock Divider —

Unit [ I,

66.667 MHz

To AFG ‘
e

Figure 53: Connection diagram for measuring amplitude with disturbing signal OFF and DUT
signal ON -AFG

Connection diagram for Test fixture compensation (DUT signal is ON and
disturbing signal is OFF)

Connect the equipment as explained in the following procedure:

1.
2.
3.

Set the DUT to generate and transmit test mode 4 signal.
Connect the Ethernet cable to J700 and the test port of the DUT.

Disconnect the BNC cable to (AWG/AFQG) at J690 and J790 point on text
fixture.

If AWG/AFG is already connected, switch off the disturber signal generator.
Short jumpers J621, J630, J623, J721, J723, 1680 and J781.

Connect the differential probe to P18 and the configured channel of the
oscilloscope.

In the Calibration tab, select theRun button in Step-3 in test fixture
compensation pane.

NOTE. Ensure that the "+" on the probe tip aligns with " < " on the text
fixture board. This takes care of the polarity being not reversed.
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D. Connection diagram for
software Signal correction TROANE
or None method (AWG/ : ¢
AFG) | I—
Tl

Tektronix oscilloscope

)

To AWG ‘
CH1+m  ygo0 |

cH2-'m 790 |

o

Figure 54: Connection diagram for Software Signal Correction or None method-AWG
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Tektronix AFG

Tektronix oscilloscope

Dooo ‘

TC5
AFG J690 1
AFG»T.V J790 | i[ﬂlﬂE]_m
= i 7’ ’ ‘
a0
=2 [0
Y TopuT

Figure 55: Connection diagram for Software signal correction or None method-AFG

Measurement for 1.

Click Apply after completing the calibration.
Transmitter Distortion

2. Click Measurement tab, and then select one of the options from the
Configuration tab.
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a.

Hardware Clock Divider option

'+ Compliance Mode ' User Defined Mode

Global Settings Calibration

- Transmit Clock Frequency
[=)- Transmitter Timing Jitter
Transmitter Timing Jitter - Master Jitter
Transmitter Timing Jitter - Slave Jitter
Transmitter Output Droop
. Transmitter Power Spectral Density
- Transmitter Peak Differential Output
Transmitter Distortion
Retum Loss

External Ref Clock Input
() Hardware Clock Divider

'+ ) Software Signal Correction

) None

Figure 56: Hardware Clock Dvider

Select the Hardware Clock Divider check box.

The Software Signal Correction is selected by default.

Make the connection setup with the clock divider as shown in
Diagram C (AWG/AFG). The clock divider synchronizes the
oscilloscope and the disturber source.

NOTE.

In case the automaton with AFG/AWG is selected in the Global
setting tab, the disturber pattern is automatically loaded during
the disturber compensation process.

In case of an unstable 10 MHz clock output from the Clock
Divider Unit, clear the Hardware Clock Divider option.

Check the amplitude of the 10 MHz clock coming from Clock
Divider Unit; it should not exist the limit mentioned on the
oscilloscope and AFG/AFG for 10 MHz reference input signal.

If the External Reference Clock signal is stable (10 MHz), the
oscilloscope will phase-lock with the external reference clock.
This can be seen in the following image as "XRef", which
indicates acquired signal is properly locked. The oscilloscope
displays "NoRef", in case of unlocked phase. It indicates that the
External Reference Clock is not proper and can result in
incorrect results.
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s 10us
1ys s

Figure 57: XRef

m  Click Start to start the test and then make the connections as shown
in the following schematic; click OK to continue the measurement.

-— Tedtrenix cacllcacape

7| | rer ok s

Tast Blura [TF-GEE)
To cacilescope

DUT Tx CHISMAL

10 Wz

COBETMHE T ook Dividar Unit |

T AWE i % TCS

CH 1+ JESD

CHZ- J790

L

i

=B 8= =84

Figure 58: Setup configuration
b. Software Signal Correction or None option
= Select the Software Signal Correction or None option.

= Make the connection setup without the clock divider as shown in
above Diagram D (AWG/AFG).

m  Click Start to start the test, and then click OK to continue the
measurement.

m  For the Software Signal Correction option, the measurement corrects
the acquired signal and adjusts the phase like a hardware clock
divider unit and then performs the peak distortion.
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Measurement setup and  Table 20: Measurement setup and algorithm
algorithm

Item Requirements

Signal type Test mode 4

Measurement algorithm outputs All the computed 10 peaks must be less than
15mV.

Measurement algorithm inputs Test mode 4 signal captured in differential form
Disturbing Signal

Limits Lower limit: NA

Upper limit: 15 mV

TekExpress Automotive-Ethernet solution executes the calculations described
below for the transmitter distortion measurement:

1. Software Signal Correct
2. Compute the unit interval of the acquired test mode 4 signal.

3. Determine the number of frames and the start and end of the frames (each
frame is 2047 bits long) in the acquired signal. Neglect the residual signal
present at both the start and the end of the acquired signal.

Ensure that all further processing happens from start of the k™ frame to end
of n'™ frame.

4. Compute the DC offset and remove the DC offset from the signal. Filter the
signal using an HPF with a cutoff frequency of 1.068 MHz If LPF is enabled,
then filter the signal using an LPF with a cutoff frequency of 33 1/3 MHz.

5. Using the start and end frames information, do averaging across frames and
finally get an averaged frame containing 2047 symbols or (2047*k) samples
where k is number of samples per symbol.

6. Do single acquisition and collect 2047 samples corresponding to a phase
offset. These 2047 samples are picked from 2047 symbols and so each
sample represents a symbol.

The application removes the disturber signal as per the [EEE
802.3 MATLAB code.

7. Repeat the previous two steps for phase offsets 0 to 1 Ul in steps of 0.1 UI
(10 phase offsets). A total of 10 peak errors/peak distortions are obtained.
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See also  Plots

Know limitations

Return Loss

This test confirms that the Return Loss of the DUT is within conformance limits.

Test setup: Return Loss
calibration and Return
Loss measurement

Specification =

BroadR-Reach Physical Layer Transceiver Specification for Automotive
Applications, version 3.2, section 8.2.2

BroadR-Reach Physical Media Attachment Test Suite version 2.0, section
5.6

Required test equipment  In addition to the DUT and oscilloscope, you will need the following:

Two supported differential probes

Three BNC cables (for connecting AFG or AWGS5K to fixture) or three SMA
cables with two BNC to SMA connectors (for connecting AWG7K to fixture)
and TCA-BNC or TCA-SMA adapters (auxiliary)

Four inch short RJ45 connector

GPIB cable (required if you use AWG automation, connects AWG and
oscilloscope)

Test fixtures: TF-GBE-BTP and fixture with loads (Open, Short, and Load)

Test setup procedure for ~ The Return Loss measurement setup involves the DUT, test fixture, AWG/AFG,
Return Loss test  and the oscilloscope.

Connect the equipment as shown in the below connection diagram and as
explained in the following procedure.

1.

2
3.
4

Make the connections as shown in the below connection diagram.
Perform the Load, Open, and ShortCalibration.
Set the DUT to generate a test mode signal 4.

Connect a BNC cable/SMA cable to (AWG/AFG)+ terminal on TC1 and
Channel 1 of AWG/AFG.

TekExpress Automotive Ethernet 3.2 Printable Application Help 107



BroadR-Reach measurements

108

10.

Connect a BNC cable/SMA cable to (AWG/AFG)— and CH1 (CHI inverted )
of the AWG/AFG 3.

NOTE. Ensure Channel 1 is connected to P1 of TC1 of TF-GBE-BTP and
Channel 2 to P2 of TC1. Do not reverse Channel I to P2 and Channel 2 to
P1. This will affect the machine.

Connect the marker1 to the auxiliary channel of oscilloscope.

Connect one differential probe to P1 of TC1 fixture and another differential
probe to P2 of TC1 fixture.

Connect the GPIB/LAN/USB cable between AWG/AFG and the
oscilloscope.

Select the Signal Generator option from Global Settings Tab.

NOTE. List of signal generators are shows in Global Settings Tab based on
TekExpress Instrument Control Settings. Here you can select the connected
signal source in Search Criteria and then click Refresh button. The
connected signal sources will automatically display in Retrieved Instruments
list and Global Settings's Tab under 'Signal Generator' list.

NOTE. To setup the signal source manually, copy the related pattern from C:
\Program Files\Tektronix\TekExpress\TekExpress Automotive Ethernet\AWG
Waveforms\Return Loss to USB memory stick. Recall this setup file on
connected signal source.

Click RUN button.

It will automatically transfer the Return loss pattern data to AWG/AFG,
whichever is been selected, in the Signal generator of Global setting tab.

NOTE.

m  Ensure that the "+" on the probe tip aligns with " < " on the text fixture
board. This takes care of the polarity being not reversed.

m  Set the attenuator factor to 1X on the probe.

m  Step 8 and 9 are applicable and followed for Return Loss Load, Short
and Open.

m  Performing Calibration is recommended before executing the Return
Loss measurement, and Ensure that you click the Apply button on the
Calibration tab for execution of Return Loss measurement.

m  FEnsure differential high impedance probe heads and probe wires should
not touch each other as it effects the Calibration results in Return Loss
measurement.

m  During calibration, the signal source AFG/AWG will be setup
automatically from the application, by loading the disturber pattern.

m  When you click on the Start button, the AFG/AWG does not setup, only
oscilloscope will setup because the application will not disturb the
calibration done using AFG/AGW.
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Return Loss test (AWG/ Tektronix AWG
AFG)

Tektronix oscilloscope

1@
L

L%

T
Load Open Shod

o of
3]
J230

(o of8
P2

J240

P3
J231
P4

oo O <«
P6

J241

1243 242

o0 m
P5

J233 1232

To DUT
(or fixture for calibration)

J200

P7
P8
i

o8 s

Figure 59: Connection diagram for Return Loss test (AWG)
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Tektronix AFG
Tektronix Oscilloscope

USB Memory Stick i CH1
for Manual Setup

(AFG patter)

Ellg

| BNC Cable # J
! é ~ -
Test fixture il
(TF-GBE) , B
'\ For calibration P I
- (L &
L s § -
s |

IJ‘; L
28= 2B= -
e [ =% Gl |
CH1 £ s
" gsg §EE | TDIDUTfurWEﬂﬁ ~
CH2 ‘A/ H~ S8Hw J200 = §.
2R: Qe | =L |8
- 4_‘7
B
S
[

Figure 60: Connection diagram for Return Loss test (AFG)
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Return Loss calibration- Toklronix AFG o
Loa d — Tektronix Oscilloscope
Output
ﬁ 11 = % g % z
USB Memory Stick @ CH1| [cH2 — TTLOutput \ 8835
for Manual Setup Bl ‘[f U [c] @‘ (¢ ©
(AFG patter) ' = |
BNC Cable g J tHs
‘ - ﬁ( 8
Test fixture 1( | el
\ - &
For calibration ‘E
AY s I8 Pl

(o o [all = | [} 115

]
=3
(=}
| ]
SH«~
¥ i ,.;77
-~ -~ 5
To AFG - EBE gag 8_
CH1 «q v I )
\ W Y06 S0 To DUT for calibration /' = )
gHe 8He 1 P
CH2 - g/= 8B " | ’ | g
— |

Figure 61: Return Loss calibration-Load
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Return Loss calibration- Tektronix AFG

Short U

Tektronix Oscilloscope

USB Memory Stick & CH 1

for Manual Setup

(AFG patter)

Test fixture
(TF-GBE)

P1

P2 |

J240
J230

To AFG Q- =0
iH=z EH=
CH1+ _'E “E
o~ o~ ~ T
Sz 8Bz | T -
2 |
| @ ) J200 B
e oHe | @ | :
c
2
o
‘ j:
L
I —

Figure 62: Return Loss calibration-Short
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Return Loss calibration- Tekironix AFG

Open B ) e

Tektronix Oscilloscope
_—

USB Memory Stick i CH1 CH2 TTL Output o]
for Manual Setup ‘ S| T “ﬂ H : ‘T m ﬂ“
(AFG patter) I : £

J CH4
' BNC Cable J
} éf ~ =
Test fixture il

f 5

Ll &

e — For calibration A e
§| Q

\ il o]

X =

\\ 18

J240
P1

4230

oac
P2

- - =
TuAFG» : gE&w gaa %
CH1 ‘H -
: o~ o To DUT for calibration -
‘EE.& EEE | -

/ e — - =
oz 8= 8B= | |®
o

®
- S
1

Figure 63: Return Loss calibration-Open

AFG configuration  In Return loss, there is no automatic control of AFG. You have to manually load
the required pattern from C:\Program Files\Tektronix \TekExpress\TekExpress
Automotive-Ethernet\ AWG Waveforms\Return Loss\AFG3000.

Following parameters are set in AFG, when you recall the setup file:

1. Go to the Calibration tab of the Return Loss and click on the link given at the
bottom of the Calibration tab.

2. Click RUN button, which automatically transfer the Return Loss pattern to
AFG/AWG.

The pattern is set to arbitrary.

TekExpress Automotive Ethernet 3.2 Printable Application Help 113



BroadR-Reach measurements

3. There are three Calibration Runs mainly Load, Open, and Short . For each of
these Runs, Ensure that the AFG is loaded with the pattern as mentioned in

the above path before clicking the Qs button.

NOTE. For manual setup of AFG, Copy the RL1000_AFG3000.TFS and
RLI1000_AFG3000.tfw (AFG setup file) files to the USB memory and recall
on AFG.

Measurement setup and  The Return Loss measurement is divided into the following three steps:
algorithm I

g 1. Return Loss calibration
2. Computation of error coefficients

3. Computation of cable return loss

Table 21: Measurement setup and algorithm

Item Requirements
Configuration parameters 1. Smoothing factor
Signal type Test mode 4

Measurement algorithm outputs Return loss in dB for frequency ranging from 3 MHz to
100 MHz
Calibration Gamma_Open, Gamma_Short and Gamma_Load
corresponding to open, short and load terminations
Computation of Error coefficients a, b, and ¢
coefficients

Computation of cable | 1. Return_loss_100 Ohm loads
loss return

Measurement algorithm inputs

Calibration Differential waveforms captured at probe point P1 and P2
Load Type

Computation of Gamma_Open, Gamma_Short and Gamma_Load

coefficients computed during calibration
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Item Requirements
Computation of cable | Differential waveforms captured at probe point P1 and P2
loss return Load Type

Limits Lower limit: NA

Upper limit: Return Loss (f) = 20 (in dB) for f = 1 to 30 MHz
=20 - 20 * log4(f/30) (in dB) for f = 30 to 66 MHz

Plots A plot containing return loss versus frequency and mask
obtained with above limits

Measurement algorithm  Calibration

The calibration procedure is required to correct for probe and fixture loading in
the final measured result. Calibration is done using three loads: open, short, and
100 Q load.

TekExpress Automotive-Ethernet solution executes the calculations described
below for the return loss calibration:

1. Multiply the acquired signals using Gaussian window (convolving in
frequency domain) and then compute the reflected and incident voltages.

Reflected voltage = (2*P1 — P2)
Incident voltage = P1
2. Return loss is computed as follows:
Return loss = FFT(Reflected voltage)/ FFT(Incident voltage)

This return loss is computed for three types of loads: Open, Short, 100 Q
load. Let the return loss computed be Gamma_Open, Gamma_Short, and
Gamma_Load for open, short, and 100 Q load, respectively. The
Gamma_Open, Gamma_Short,and Gamma_Load are dumped in csv files.

3. For plotting purpose, Gamma_Open, Gamma_Short, and Gamma_Load are
converted to dB scale, interpolated, and smoothed. Interpolated and
smoothed Gamma_Open, Gamma_Short, and Gamma_Load are plotted for
visual representation.

Computing error coefficients

TekExpress Automotive Ethernet solution executes the calculations described
below for the return loss error coefficient calculation.

1. Gamma Open, Gamma_ Short, and Gamma Load are used for computing the
following three coefficient that are required for computing cable return loss:

a. b—Gamma_ Short + ¢ ¥ Gamma_Short
b. Gamma [oad

c¢. (Gamma_Short + Gamma Open —2 * b) / (Gamma_Short —
Gamma_Open)

Computing Return Loss
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TekExpress Automotive Ethernet solution executes the calculations described
below for the return loss:

1. Multiply the acquired signals using Gaussian window (convolving in
frequency domain) and then compute the reflected and incident voltages.

Reflected voltage = (2*P1 — P2)
Incident voltage = P1
2. Return loss is computed as follows:
Return loss = FFT(Reflected voltage)/ FFT(Incident voltage)
Let the computed return loss be GammaValue.

3. Read the error coefficients a, b, and ¢ from the dumped csv files. Compute
the corrected return loss using a, b, and c.

Corrected Return loss = (GammaValue — b)/(a — ¢ ¥ GammaValue)
This return loss is for 100 Q load. Let this be return_loss 100.

4. For plotting purposes, Return Loss 100 is converted to dB scale,
interpolated, and smoothed. Interpolated and smoothed Return_Loss 100 is
plotted for visual representation.

Return _loss 100 is compared with the specification given limit.

Hints when Return Loss  Ensure you:
fails o .
m  Performed Scope SPC calibration, ensure that it passed.
m  Used 6" Ethernet interconnect cable, a different one than earlier tests.

m  Ran with default configuration (like 200 avg count).

Seealso  Plots

Know limitations
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Known limitations

The following are the know limitations:

1.

Return Loss and Transmitter Distortion measurements needs Calibration
before RUN. Calibration is recommended when there is a change in the
setup.

In Return Loss measurement, when you select 'Use pre-recorded waveform'
option for Calibration for the first time, then an error message is displayed as
'Calibration files not present'. It is recommended to RUN the live Calibration
before you select the pre-recorded option.

When you recall the Return Loss measurement session file, the Calibration
files are not recalled. You need to set/load the Calibration files manually.

Y ou cannot stop or pause Calibration RUN during its execution. (This is
applicable for both Return loss and Transmitter Distortion measurement)

The Plots are different when you RUN the Return Loss in pre-recorded mode
for the first time, when compared to subsequent RUNS.

Wait ( max of 3-4 minutes) till the RUN button is enable to use. Do not press
RUN button till application is ready.

When the application is not able to work with LAN connection for AFG, use
USB-GPIB cable to connect AFG to scope. Ensure that instrument refresh is
performed in the TekExpress application, before configuring signal source in
the Global settings tab.
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Measurement error messages

The following table lists all of the error messages associated with BRR
measurements and their definitions.

Table 22: Measurement error messages

Error message ‘ Description

Transmitter Output Droop measurement (Test Mode 1)

Signal Validation failed for Test Mode 1. Make sure that | This error occurs if the input signal
input signal has: does not meet the requirements given
in specification for test mode 1 signal.

= Edge to Edge period deviation is less than 10% Edge to Edge period 33 unit intervals

= Atleast 2 Unit Intervals (500 ns)

Signal validation failed for Test Mode 1.Make sure that This error occurs if the input signal

input signal has: has Rise to Rise period deviation of
. . . e more than 10%. Rise to Rise period

= Rise to Rise period deviation is less than 10%. value (500 ns)

Signal validation failed for Test Mode 1.Make sure that This error occurs if the input signal

input signal has: has Fall to Fall period deviation of

more than 10%. Fall to Fall edge

= Fall to Fall period deviation is less than 10%. period value (500 ns)

Signal validation failed for Test Mode 1.Make sure that This error occurs if the input signal
input signal has: does not meet the Edge to Edge
period greater than 500 nano

= Edge to Edge period is greater than 500 nano seconds

seconds

Transmitter Clock Frequency measurement and Transmitter Timing Master Jitter
measurements (Test Mode 2)

Signal Validation failed for Test Mode 2. Make sure that: | This error occurs if the input frequency

f th ired test mode 2 signal i
= The unitinterval/frequency of the signal does not Sarieesice?/lé;;z 6&52/?)0“/'6}_'2 i|gna s

deviate beyond + 100 ppm from 66(2/3) MHz. 100 ppm

Signal Validation failed for Test Mode 2. Ensure that input | This error occurs if the input signal
signal has: has Rise to Rise period deviation of

than 10%.
= Rise to Rise period deviation is less than 10%. more than 10%

Signal Validation failed for Test Mode 2. Ensure that input | This error occurs if the input signal
signal has: has Fall to Fall period deviation of

more than 10%.
= Fall to Fall period deviation is less than 10%. &
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Error message

Description

Signal validation failed for Test Mode 2.Make sure that
input signal has:

= Edge to Edge period deviation is less than 10%
compared to 66(2/3) MHz Tx_CIk.

= Atleast 2 Unit Intervals,

= Inputis not clock signal (Test Mode 2).

This error occurs if the input signal
has:

= Edge to Edge period deviation is
more than 10% compared to
66(2/3) MHz Tx_Clk.

= More than two cycles are need to
execute the measurement.

= Input signal is not a clock signal
(Test Mode 2).

Transmitter Timing Slave Jitter measurement (Test Mode 3)

Signal validation failed for TX_TCLK signal. Make sure
that:

= The Edge to Edge deviation is less than 10%.

This error occurs if the input signal
does not meet the requirements given
in specification for TX_TCLK signal.

Signal validation failed for TX_TCLK signal. Make sure
that input signal has:

= Rise to Rise period deviation is less than 10%.

This error occurs if the input signal
does not meet the requirements given
in specification for TX_TCLK signal.

Signal validation failed for TX_TCLK signal. Make sure
that input signal has:

= Fall to Fall period deviation is less than 10%.

This error occurs if the input signal
does not meet the requirements given
in specification for TX_TCLK signal.

Transmitter Distortion and Return Loss measurements

(Test Mode 4)

Signal Validation failed for Test Mode 4. Ensure that input
signal:

= |s PAM3 modulated
= Has at least 3 frames of Test Mode 4 (2047 bits).

= The common possible cause could be polarity of the
probing points being reversed. Ensure Probe tip '+
aligns with '<" on the test fixture board.

This error will occur if the input signal
does not meet the requirements given
in specification for test mode 4 signal.

Signal Validation failed for Test Mode 4. Ensure that:

= Interval/frequency of the Clock signal does not
deviate beyond + 100 ppm from 66(2/3) MHz.

This error occurs if the input signal
does not meet the requirements given
in specification for test mode 4 signal.
Follow the instruction and step 3. For
more information, see Table 20:
Measurement setup and algorithm.

Return Loss and Power Spectral Density measurements (Test Mode 5)

Calibration files are not present for return loss
measurement. Either Deselect the Measurement or Stop
the Execution, Perform Calibration and Re-Run the test.

This error occurs if return loss
measurement is executed without
calibration files. Always run the
calibration and then execute return
loss measurement. If calibration is
done, return loss measurement uses
latest available calibration files.
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Error message

Description

Error message applicable to all tests

Not Enough Edges in the Waveform. Acquire the
waveform for a longer duration.

This error occurs If the input signal
does not have enough rise to fall and
fall to rise transitions.

Data points acquired is insufficient for moving average
filtering. Set the start frequency, stop frequency and RBW
such that (stop frequency - start frequency)/RBW is
greater than 3.

User should check the start frequency,
stop frequency and RBW setting. This
error will occur If the waveform does
not have enough frequencies between
the start and stop frequency.

Captured Signal has less than 3 segments, Please
increase Record Length.

This error occurs If the input signal
has less than three segments of test
mode 4 signal (2047 bits).

Unable to run because return loss measurement is not
calibrated. Calibrate and apply the return loss
measurement, and then click on start.

This error occurs if user tries to
execute return loss measurement
without applying calibration
(computation of error coefficients).

Invalid Signal at CH1. Please check DUT connections and
re-run the test.

This error occurs if an invalid signal is
fed as input to return loss
measurement (wrong connection).

Signal validation failed for Test Mode.Input waveform is
not found.

This error occurs when waveform is
not found for signal validation.
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About the programmatic interface

The Programmatic interface allows you to seamlessly integrate the TekExpress
test automation application with the high-level automation layer. This also allows
you to control the state of the TekExpress application running on a local or a
remote computer.

For simplifying the descriptions, the following terminologies are used in this
section:

= TekExpress Client: A high-level automation application that communicates
with TekExpress using TekExpress Programmatic Interface.

= TekExpress Server: The TekExpress application when being controlled by
TekExpress Client.

TekExpress leverages .Net Marshalling to enable the Programmatic Interface for
TekExpress Client. TekExpress provides a client library for TekExpress clients to
use the programmatic interface. The TekExpress client library is inherited

from .Net MarshalByRef class to provide the proxy object for the clients. The
TekExpress client library maintains a reference to the TekExpress Server and this
reference allows the client to control the server state.

et C# HNet VB HNet Web TestStand
Client Client Client Client
FY Y
\ h 4 L4 ./
TekEzpressChent Library
¥
TekExpress
See also

Requirements for developing TekExpress client
Remote proxy object

Client proxy object
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Requirements for developing TekExpress client
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While developing TekExpress Client, use the TekExpressClient.dll. The client
can be a VB .Net, C# .Net, TestStand or Web application. The examples for
interfaces in each of these applications are in the Samples folder.

References Required

m  TekExpressClient.dll has an internal reference to /ldlglib.dll and
IRemotelnterface.dll.

®  JIdiglib.dll has a reference to TekDotNetLib.dll.

®  [Remotelnterface.dll provides the interfaces required to perform the remote
automations. It is an interface that forms the communication line between the
server and the client.

m  [Idiglib.dll provides the methods to generate and direct the secondary dialog
messages at the client-end.

NOTE. The end-user client application does not need any reference to the above
mentioned DLL files. It is essential to have these DLLs (IRemotelnterface.dll,
11diglib.dll and TekDotNetLib.dll) in the same folder as that of
TekExpressClient.dIl.

Required Steps for a Client

The following are the steps that a client needs to follow to use
TekExpressClient.dll to programmatically control the server:

A client UI must be developed to access the interfaces exposed through the
server. This client needs to load TekExpressClient.dll to access the interfaces.
After TekExpressClient.dll is loaded, the client Ul can call the specific functions
to run the operations requested by the client. When the client is up and running, it
must do the following to run a remote operation:

1. The client needs to provide the IP address of the PC at which the server is
running in order to connect to the server.

2. The client needs to lock the server application to avoid conflict with any
other Client that may try to control the server simultaneously. “Lock” would
also disable all user controls on the server so that server state cannot be
changed by manual operation. Note that this does not lock the UI.

If any other client tries to access a server that is locked, it will get a
notification that the server is locked by another client.

3. When the client has connected to and locked the server, the client can access
any of the programmatic controls to run the remote automations.

4. After the client operations are completed, the server needs to be unlocked by
the client.

See also

About TekExpress Automotive Ethernet application commands
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Remote proxy object

The server exposes a remote object to let the remote client access and perform the
server side operations remotely. The proxy object is instantiated and exposed at
the server-end through marshalling.

MarshalByEef

TekExpressClient

TekExpress RemoteProxyOhiject

The following is an example:

RemotingConfiguration.RegisterWellKnownServiceType (typeof
(TekExpressRemotelnterface), “TekExpress Remote interface”,
WellKnownObjectMode.Singleton);

This object lets the remote client access the interfaces exposed at the server side.
The client gets the reference to this object when the client gets connected to the
server.

For example,
//Get a reference to the remote object

remoteObject =
(IRemotelnterface)Activator.GetObject(typeof(IRemotelnterface),
URL.ToString());
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Client exposes a proxy object to receive certain information.

MarshalByEef

TekExpress [ ohonprm ryCbject TekExpressClient

For example,
//Register the client proxy object

WellKnownServiceTypeEntry[] e =
RemotingConfiguration.GetRegisteredWellKnownServiceTypes();

clientInterface = new ClientInterface();

RemotingConfiguration.RegisterWellKnownService Type(typeof(ClientInterface)
, “Remote Client Interface”, WellKnownObjectMode.Singleton);

//Expose the client proxy object through marshalling
RemotingServices.Marshal(clientInterface, "Remote Client Inteface");
The client proxy object is used for the following:

= To get the secondary dialog messages from the server.

m  To get the file transfer commands from the server while transferring the
report.

Examples
clientObject.clientIntf.DisplayDialog(caption, msg,iconType, btnType);
clientObject.clientIntf. TransferBytes(buffer, read, fileLength);

For more information, click the topic links listed below.

Secondary dialog message handling
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MarshalByEef
¥
Client Proxyobject .
TekEzpress |4 TelExpressClient
T Display Diskogl)
sSecondary Dialog

The secondary dialog messages from the Secondary Dialog library are redirected
to the client-end when a client is performing the automations at the remote end.

In the secondary dialog library, the assembly that is calling for the dialog box to
be displayed is checked and if a remote connection is detected, the messages are
directed to the remote end.

File transfer events

When the client requests the transfer of the report, the server reads the report and
transfers the file by calling the file transfer methods at the client-end.

Program examples

The following program examples show how to communicate between a PC and
TekExpress Automotive Ethernet remotely, using typical steps.

For detailed information about each command, see the TekExpress Automotive
Ethernet Application Commands section.

Table 23: Remote access code example 1

Task Code
Start the application

Connect through an IP address. {'Set String Details

string devicename = "BRR”

string suitename = "BRR”
m_Client.Connect("localhost")True or False
clientlD = m_Client.getClientID }

Lock the server m_Client.LockServer(clientID)
Disable the Popups m_Client.SetVerboseMode(clientID, false)
Set the DUT ID m_Client.SetDutld(clientID, "DUT_Name")
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Task

Code

Select channels

m_Client.SetGeneralParameter(clientID,
devicename, suitename, Testname, "Source
Data$CH1");
m_Client.SetGeneralParameter(clientID,
devicename, suitename, Testname, "Source
Data$CH2");
m_Client.SetGeneralParameter(clientID,
devicename, suitename, Testname,
"Probe2$C2");"This Probe2 is for selecting
Source 2 for return Loss"

Select a measurement

m_Client.SelectTest(clientID, devicename,
suitename, "Return Loss", True)

Configure the selected measurement (Acquire
Parameters)

m_client.SetAcquireParameter(clientID,
devicename, suitename,"Transmit Clock
Frequency","Average$60");
m_client.SetAcquireParameter(clientID,
devicename, suitename," Transmit Clock
Frequency","Record Length$10" );
m_client.SetAcquireParameter(clientID,
devicename, suitename," Transmitter
Distortion","TX_TCLK$Included" );
m_client.SetAcquireParameter(clientID,
devicename, suitename," Transmitter
Distortion","Average$100" );
m_client.SetAcquireParameter(clientID,
devicename, suitename," Transmitter
Distortion","Disturbing Signal$False" );
m_client.SetAcquireParameter(clientID,
devicename, suitename," Transmitter
Distortion","High Resolution$50" );

Configure the selected measurement (Analyze
Parameters)

m_client.SetAnalyzeParameter(clientID,
devicename, suitename," Transmitter
Distortion","LP Filter$Included")
m_client.SetAnalyzeParameter(clientID,
devicename, suitename," Transmitter
Distortion","RBW$50")
m_client.SetAnalyzeParameter(clientID,
devicename, suitename," Transmitter
Distortion","Center Frequency$75")
m_client.SetAnalyzeParameter(clientID,
devicename, suitename," Transmitter
Distortion","Frequency Span$200")

Run with set configurations

m_Client.Run(clientID)
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Task Code
Wait for the test to complete Do
Thread.Sleep(500)

m_Client.Application_Status(clientID)

Select Case status

Case "Wait"

'Get the Current State Information
mClient.GetCurrentStatelnfo(clientID,
WaitingMsbBxCaption, WaitingMsbBxMessage,
WaitingMsbBxButtontexts)

'Send the Response
mClient.SendResponse(clientID,
WaitingMsbBxCaption, WaitingMsbBxMessage,
WaitingMsbBxResponse)

End Select

Loop Until status = "Ready"

After the test is complete ‘Save all results values from folder for current
run

m_Client.TransferResult(clientID, logDirname)
‘Save all waveforms from folder for current run
m_Client.TransferWaveforms(clientID,
logDirname)

'Save all images from folder for current run
m_Client. Transferlmages(clientID, logDirname)

Unlock the server m_Client.UnlockServer(clientID)

Disconnect from server m_Client.Disconnect()

Exit the application

Table 24: Remote access code example 2

Task Code

Start the application

Connect through an IP address. m_Client.Connect("localhost") 'True or False
clientlD = m_Client.getClientID

Lock the server m_Client.LockServer(clientID)

Disable the Popups m_Client.SetVerboseMode(clientID, false)

Set the DUT ID m_Client.SetDutld(clientID, "DUT_Name")

Select a test mClient.SelectsingleTest(clientID, "BRR",
"BRR", “Spec 1.0”, "Transmitter Distortion", true)

Set Disturbing Signal mClient.SetAcquireParameter(clientID, "BRR",
"BRR", "Transmitter Distortion","Disturbing
Signal$False")

Set Record Length mClient.SetAcquireParameter(clientID, "BRR",
"BRR", "Transmitter Distortion","Record Length
$1 0ll)

Run with set configurations m_Client.Run(clientID)
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Task Code
Wait for the test to complete. Do
Thread.Sleep(500)

m_Client.Application_Status(clientID)
Select Case status
Case "Wait"

Get the current state information mClient.GetCurrentStatelnfo(clientID,
WaitingMsbBxCaption, WaitingMsbBxMessage,
WaitingMsbBxButtontexts)

Send the response mClient.SendResponse(clientID,
WaitingMsbBxCaption, WaitingMsbBxMessage,
WaitingMsbBxResponse)

End Select

Loop Until status = "Ready"

Save results Save all results values from folder for current run
m_Client.TransferResult(clientlD, logDirname)

Unlock the server m_Client.UnlockServer(clientID)

Client programmatic interface example

An example of the client programmatic interface is described and shown as
follows:
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Connect to Remote Object

!

Get Client ID

!

Lock Server

!

Register for Status Change Notification
l Handler for Status Change Notification

Select the requested tests

!

Set the necessary Patameters for eash selected test

!

Status = ‘Wait/ Error’

Run the test
Get Status Info
Get Status l
Do Action based on Status
No
Status="Ready’ l
Set Response
Get Resuilts Return to Main Flow

!

Process the Results

!

Unlock Server

!

Disconnect from Remote Object

Stop

pn]

1. Connect to a server or remote object using the programmatic interface
provided.

2. Get the client ID that is created when connecting to the remote object. This
client ID is one of the required parameters to communicate with the server.

NOTE. Server identifies the client with this ID only and rejects any request if

the ID is invalid.
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Handler of status change
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notification

See also

®° AP

10.
11.
12.

Lock the server for further operations. This disables the application interface.

NOTE. You can get values from the server or set values from the server to the
client only if the application is locked.

Register for receiving notifications on status change events on the server. To
register you need to give a handler as a parameter.

NOTE. Whenever there is a change in the status of the server, all the clients
registered with the server receive a notification from the server.

Select the tests that you want to run through the programmatic interface.
Set the necessary parameters for each test.
Run the tests.

Poll for the status of the application.

NOTE. Skip this step if you are registered for the status change notification
and when the status is Ready.

After completing the tests, get the results.
Create a report or display the results and verify or process the results.
Unlock the server after you complete all the tasks.

Disconnect from the remote object.

Get the status. If the status is Wait or Error, get the information that contains
the title, message description, and the expected responses for the status.

Perform the actions based on the status information.

Set the response as expected.

About TekExpress Automotive Ethernet Application Commands

Program examples
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TekExpress Automotive Ethernet application commands

About TekExpress
Automotive Ethernet
application commands

Connect through an IP
address

TekExpress Automotive Ethernet 3.2 Printable Application Help

Click a client action below to see the command name, description, parameters,
return value, and an example, associated with the action.

Connect through an IP address

Lock the server

Disable the popups
Set or get the DUT ID

Set the configuration parameters for a suite or measurement

Query the configuration parameters for a suite or measurement

Select a measurement

Select a suite

Run with set configurations or stop the run operation

Handle error codes

Get or set the timeout value

Wait for the test to complete

After the test is complete

Save, recall, or check if a session is saved

Unlock the server

Disconnect from server

Command name

Parameters

Description

Return value

Example

Connect()

string ipAddress
out string clientlD

This method
connects the client
to the server. Note
The client provides
the IP address to
connect to the
server.

The server
provides a unique
client identification
number when
connected to it.

Return value is
either True or
False.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL.
returnval as
boolean

returnval =
m_Client.Connect(
ipaddress,m_client
ID)
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NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by
another client".

The session is UNLOCKED and the message displayed is "Lock Session to
execute the command".

The server is NOTFOUND and the message displayed is "Server not
found...Disconnect!".

When none of these fail conditions occur, then the message displayed is
"Failed...".

string ipAddress

Name Type Direction Description

ipAddress string IN The ip address of the
server to which the
client is trying to
connect to. This is
required to establish
the connection between
the server and the

client.
out string clientlD
Name Type Direction Description
clientlD string ouT Identifier of the client
that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

NOTE.

The server must be active and running for the client to connect to the server. Any
number of clients can be connected to the server at a time.
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Lock the server

NOTE. This method does not lock the UL but you need this method to set the value
that gives the status of the operation after it has been performed.

Command name | Parameters Description Return value Example

LockSession() out string clientlD | This method locks | String value that | m_Client = new
the server. Note | gives the status of | Client() //m_Client
The client must | the operation after | is a reference to

call this method | it has been the Client class in
before running any| performed. the Client DLL.

of the remote The return value is| returnval as string
automations. The | "Session returnval =

server can be Locked...” on m_Client.LockServ
locked by only one| success. er(clientlD)

client.

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by
another client”.

The session is UNLOCKED and the message displayed is "Lock Session to
execute the command".

The server is NOTFOUND and the message displayed is "Server not
found...Disconnect!".

When none of these fail conditions occur, then the message displayed is
"Failed...".

out string clientiD

Name Type Direction Description

clientlD string ouTt Identifier of the client
that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

NOTE. When the client tries to lock a server that is locked by another client, the
client gets a notification that the server is already locked and it must wait until
the server is unlocked. If the client locks the server and is idle for a certain
amount of time then the server is unlocked automatically from that client.
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Disable the popups | Command name | Parameters Description Return value Example

SetVerboseMode() string clientlD This method sets | String that m_Client = new
bool _verbose the verbose mode | displays the status| Client() //m_Client
to either True or | of the operation | is a reference to

False. after it has been | the Client class in
When the value is | performed. the Client DLL.
set to True, any of | When Verbose returnval as string
the message mode is set to Verbose mode is
boxes appearing | True, the return | turned on

during the value is “Verbose | return=m_Client.S

application run will| mode turned on. | etVerboseMode(cli
be routed to the | All dialog boxes | entID, True)

client machine that| will be shown to | Verbose mode is
is controlling client...”. turned off
TekExpress. When Verbose returnval=m_Clien
When the value is | mode is set to t.SetVerboseMod
set to False, then | False, the return | e(clientID, False)
all the message | value is “Verbose
boxes are shown | mode turned off.

on the server All dialog boxes
machine. will be shown to
server...".

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by
another client".

The session is UNLOCKED and the message displayed is "Lock Session to
execute the command".

The server is NOTFOUND and the message displayed is "Server not
found...Disconnect!".

When none of these fail conditions occur, then the message displayed is
"Failed...".

out string clientiD

Name Type Direction Description

clientlD string ouTt Identifier of the client
that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70
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bool verbose

TekExpress programmatic interface

Name Type Direction Description
_verbose bool IN Specifies whether the
verbose mode should
be turned ON or OFF
Command name | Parameters Description Return value Example
SetDutld() string clientlD This method String that gives | m_Client = new
string dutName | changes the DUT | the status of the | Client() //m_Client
ID of the setup. | operation afterit | is a reference to
The client must | has been the Client class in
provide a valid performed. the Client DLL.
DUT ID. Return valueis | returnval as string
“DUT Id return=m_Client.S
Changed...” on | etDutld(clientID,de
success. siredDutld) Note
GetDutld() string clientlD This method gets | String that gives | m_Client = new

string dutld

the DUT ID of the
current set up.

the status of the
operation after it
has been

performed.

Client() //m_Client
is a reference to

the Client class in
the Client DLL.
returnval as string
return=m_Client.G
etDutid(clientID,

out Dutld)

out string clientlD

Name Type Direction Description

clientlD string out Identifier of the client
that is connected to the
server
clientlD = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

string dutName

Name Type Direction Description

dutName string IN The new DUT ID of the
setup
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string dutid
Name Type Direction Description
dutld string ouTt The DUT ID of the
setup

NOTE. If the dutName parameter is null, the client is prompted to provide a valid
DUT ID.

The dutld parameter is set after the server processes the request.

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by
another client".

The session is UNLOCKED and the message displayed is "Lock Session to
execute the command".

The server is NOTFOUND and the message displayed is "Server not
found...Disconnect!".

When none of these fail conditions occur, then the message displayed is
"Failed...".
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Set the configuration
parameters for a suite or

measurement

Command name

Parameters

Description

Return value

Example

SetGeneralParam

string clientlD

This method sets

String that

m_Client = new

eter string device the general displays the status| Client() /m_Client
string suite parameters. of the operation | is a reference to
string test after it has been | the Client class in
string performed. the Client DLL.
parameterString The return value is| returnval as string
" (an empty returnval =
String) on m_Client.SetGene
success. ralParameter(clien
tID, devicename,
suitename,
string.Empty,
parameterstring);
SetAnalyzeParam | string clientID This method sets | String that mClient = new

eter()

string device

the parameter

displays the status

Client() //m_Client

string suite values in the Ref | of the operation | is a reference to
string test Levels and Clock | after it has been | the Client class in
string Settings tabs in | performed. the Client DLL
parameterString | the test The return value is| returnval as string
configuration " (an empty Select Analyze
section. String) on parameter:
success. returnval =
mClient.SetAnalyz
eParameter(clientl
D, devicename,
suitename, test,
parameterstring)
SetAcquireParame; string clientlD This method sets | String that mClient = new

ter()

string device
string suite
string test

string
parameterString

the parameter
values in the
Vertical Setup and
the Scope Settings
tabs in the test
configuration
section.

displays the status
of the operation
after it has been
performed.

The return value
is ” (an empty
string) on success.

Client() //m_Client
is a reference to
the Client class in
the Client DLL
returnval as string
Set Acquire
Parameter:
returnval =
mClient.SetAcquir
eParameter(clientl
D, devicename,
suitename, test,
parameterstring)
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out string clientiD

Name Type Direction Description

clientlD string ouTt Identifier of the client
that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

string device

Name Type Direction Description
device string IN Specifies the name of
the device
string suite
Name Type Direction Description
suite string IN Specifies the name of
the suite
string test
Name Type Direction Description
test string IN Specifies the name of
the test to obtain the
pass or fail status

string parameterString

Name Type Direction Description
parameterString string IN Selects or deselects a
test

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by
another client”.

The session is UNLOCKED and the message displayed is "Lock Session to
execute the command".

The server is NOTFOUND and the message displayed is "Server not
found...Disconnect!".

When none of these fail conditions occur, then the message displayed is
"Failed...".
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Query the configuration
parameters for a suite or

measurement

Command name | Parameters Description Return value Example
GetGeneralParam | string clientlD This method gets | The return value is| m_Client = new
eter() string device the general the general Client() //m_Client
string suite configuration configuration is a reference to
string test parameters fora | parameter fora | the Client class in
string given suite or given suite or the Client DLL.
parameterString | measurement. measurement that | returnval as string
is set.
GetAnalyzeParam | string clientID This method The return value is| mClient = new
eter() string device queries the the configuration | Client() //m_Client
string suite parameter values | parameter fora | is a reference to
string test in the Ref Level | given suite or the Client class in
string and Clock Settings| measurement. the Client DLL
parameterString | tabs in the test returnval as string
configuration Get Analyze
section. parameter:
returnval =
mClient.GetAnalyz
eParameter(clientl
D, devicename,
suitename, test,
parameterstring)
GetAnalyzeParam
eter Examples
GetAcquireParam | string clientlD This method The return value is| mClient = new
eter() string device queries the the configuration | Client() //m_Client
string suite parameter values | parameter fora | is a reference to
string test in the Vertical given suite or the Client class in
string Setup and Scope | measurement. the Client DLL
parameterString | Settings tabs in returnval as string
the test Get Acquire
configuration Parameter:
section. returnval =
mClient.GetAcquir
eParameter(clientl
D, devicename,
suitename, test,
parameterstring)
GetAcquireParam
eter Examples
out string clientlD
Name Type Direction Description
clientlD string out Identifier of the client

that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70
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string device

Name Type Direction Description
device string IN Specifies the name of
the device
string suite
Name Type Direction Description
suite string IN Specifies the name of
the suite
string test
Name Type Direction Description
test string IN Specifies the name of
the test to obtain the
pass or fail status

string parameterString

Name Type Direction Description
parameterString string IN Selects or deselects a
test

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by
another client”.

The session is UNLOCKED and the message displayed is "Lock Session to
execute the command".

The server is NOTFOUND and the message displayed is "Server not
found...Disconnect!".

When none of these fail conditions occur, then the message displayed is
"Failed...".

GetAcquireParameter Examples

This example uses BRR test Transmitter Distortion.
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Parameter

Example

TX_TCLK

returnval =
mClient.GetAcquireParameter(clientID,
devicename, suitename,"Transmitter
Distortion","Transmitter Distortion Acquisition
$TX_TCLK")

Average

returnval =
mClient.GetAcquireParameter(clientID,
devicename, suitename,"Transmitter
Distortion","Transmitter Distortion Acquisition
$Average")

Disturbing Signal

returnval =
mClient.GetAcquireParameter(clientID,
devicename, suitename,"Transmitter
Distortion","Transmitter Distortion Acquisition
$Disturbing Signal")

Hi Resolution

returnval =
mClient.GetAcquireParameter(clientID,
devicename, suitename,"Transmitter
Distortion","Transmitter Distortion Acquisition$Hi
Resolution")

Probe Point Amplitude in V

returnval =
mClient.GetAcquireParameter(clientID,
devicename, suitename,"Transmitter
Distortion","Transmitter Distortion Acquisition
$Probe Point Amplitude in V")

Distortion Amplitude in V

returnval =
mClient.GetAcquireParameter(clientID,
devicename, suitename,"Transmitter
Distortion","Transmitter Distortion Acquisition
$Distortion Amplitude in V")

Distortion Frequency in MHz

returnval =
mClient.GetAcquireParameter(clientID,
devicename, suitename,"Transmitter
Distortion","Transmitter Distortion Acquisition
$Distortion Frequency in MHz")

DUT Amplitude in V

returnval =
mClient.GetAquireParameter(clientID,
devicename, suitename,"Transmitter
Distortion","Transmitter Distortion Acquisition
$DUT Amplitude in V")

GetAnalyzeParameter Examples

This example uses BRR test Transmitter Distortion.
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Parameter Example

LP Filter returnval
=mClient.GetAnalyzeParameter(clientID,
devicename, suitename,"Transmitter
Distortion","LP Filter")

Select a measurement Command name | Parameters Description Return value Example
SelectTest() string clientlD This method String that m_Client = new
string device selects or displays the status| Client() //m_Client
string suite deselects a given | of the operation | is a reference to
string test test. after it has been | the Client class in
bool isSelected performed. the Client DLL
The return value is| returnval as string
" (an empty Select test: (test
String) on name)
success. returnval=mClient.
SelectTest(clientlD
, devicename,
suitename,
testname,
isSelected);)
Select a specific
test.

Select a specific test

Test Command

Transmit Clock Frequency For selecting the test:
returnval=m_Client.SelectTest(clientlD, devicename,
suitename, "Transmit Clock Frequency", True);

For deselecting the test:
returnval=m_Client.SelectTest(clientlD, devicename,
suitename, "Transmit Clock Frequency", False);

Transmitter Master Timing Jitter For selecting the test:
returnval=m_Client.SelectTest(clientlD, devicename,
suitename, "Transmitter Timing Jitter - Master Jitter",
True);

For deselecting the test:
returnval=m_Client.SelectTest(clientlD, devicename,
suitename, "Transmitter Timing Jitter - Master Jitter",
False)

Transmitter Slave Timing Jitter For selecting the test:
returnval=m_Client.SelectTest(clientlD, devicename,
suitename, "Transmitter Timing Jitter - Slave Jitter", True);
For deselecting the test:
returnval=m_Client.SelectTest(clientlD, devicename,
suitename, "Transmitter Timing Jitter - Slave Jitter", False)
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Test

Command

Transmitter Output Droop

For selecting the test:
returnval=m_Client.SelectTest(clientlD, devicename,
suitename, "Transmitter Output Droop", True);

For deselecting the test:
returnval=m_Client.SelectTest(clientlD, devicename,
suitename, "Transmitter Output Droop", False)

Transmitter Power Spectral Density

For selecting the test:
returnval=m_Client.SelectTest(clientlD, devicename,
suitename, "Transmitter Power Spectral Density", True);
For deselecting the test:
returnval=m_Client.SelectTest(clientlD, devicename,
suitename, "Transmitter Power Spectral Density", False);

Transmitter Distortion

For selecting the test:
returnval=m_Client.SelectTest(clientlD, devicename,
suitename, "Transmitter Distortion", True);

For deselecting the test:
returnval=m_Client.SelectTest(clientlD, devicename,
suitename, "Transmitter Distortion", False);

Return Loss

For selecting the test:
returnval=m_Client.SelectTest(clientlD, devicename,
suitename, "Return Loss", True);

For deselecting the test:
returnval=m_Client.SelectTest(clientlD, devicename,
suitename, "Return Loss", False);

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by

another client”.

The session is UNLOCKED and the message displayed is "Lock Session to

execute the command”.

The server is NOTFOUND and the message displayed is "Server not

found...Disconnect!".

When none of these fail conditions occur, then the message displayed is

"Failed...".

out string clientlD

Name Type Direction Description

clientlD string ouTt Identifier of the client
that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70
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Select a suite

string device

Name Type Direction Description
device string IN Specifies the name of
the device
string suite
Name Type Direction Description
suite string IN Specifies the name of
the suite
string test
Name Type Direction Description
test string IN Specifies the name of
the test to obtain the
pass or fail status
bool isSelected
Name Type Direction Description
isSelected bool IN Selects or deselects a
test
Command name | Parameters Description Return value Example
SelectSuite() string clientlD This method String that gives | m_Client = new
string device selects or the status of the | Client() /m_Client

string suite
bool isSelected

deselects a given
suite.

Setting parameter
is selected to
True, you can
select a suite.
Setting parameter
is selected to
False, you can
deselect a suite.

operation after it
has been
performed.

The return value is
" (an empty
String) on
success.

is a reference to
the Client class in
the Client DLL.
returnval as string
Select Suite
(Default):
returnval=m_Clien
t.SelectTest(clientl
D, "BRR", "BRR",
True)
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NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by
another client".

The session is UNLOCKED and the message displayed is "Lock Session to
execute the command".

The server is NOTFOUND and the message displayed is "Server not
found...Disconnect!".

When none of these fail conditions occur, then the message displayed is
"Failed...".

out string clientlD

Name Type Direction Description

clientlD string ouTt Identifier of the client
that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

string device

Name Type Direction Description
device string IN Specifies the name of
the device
string suite
Name Type Direction Description
suite string IN Specifies the name of
the suite

bool isSelected

Name Type Direction Description
isSelected bool IN Selects or deselects a
test
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Run with set Command name | Parameters Description Return value Example
configurations or stop the Run() string clientlD Runs the selected | String that gives | m_Client = new
run operation tests. Note the status of the | Client() //
Once the server is | operation afterit | m_Clientis a
setup andis has been reference to the
configured, it can | performed. Client class in the

be run remotely | The return value is| Client DLL.
using this function.| "Run started..." on | returnval as string

success. returnval=m_Clien
t.Run(clientID)
Stop() string clientlD Stops the currently| String that gives | m_Client = new

running tests. Note the status of the | Client() //m_Client
operation after it | is a reference to
has been the Client class in
performed. the Client DLL.
The return value is| returnval as string
"Stopped..." on | returnval=m_Clien
success. t.Stop(clientID)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by
another client”.

The session is UNLOCKED and the message displayed is "Lock Session to
execute the command".

The server is NOTFOUND and the message displayed is "Server not
found...Disconnect!".

When none of these fail conditions occur, then the message displayed is
"Failed...".

out string clientlD

Name Type Direction Description

clientlD string out Identifier of the client
that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

NOTE. When the run is performed, the status of the run is updated periodically
using a timer.

NOTE. When the session is stopped, the client is prompted to stop the session and
is stopped at the consent.
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Get or set the timeout
value

string time

period specified by
client. After expiry
of this timeout
period, the server
is automatically
unlocked.

Command name | Parameters Description Return value Example
GetTimeOut() string clientlD Returns the String that gives | m_Client = new
current timeout | the status of the | Client() //m_Client
period set by the | operation afterit | is a reference to
client. has been the Client class in
performed. the Client DLL.
The default return | returnval as string
value is 1800000. | returnval=m_Clien
t.GetTimeOut()
SetTimeOut() string clientlD Sets a timeout String that gives | m_Client = new

the status of the
operation after it
has been
performed.

On success the
return value is
“TimeOut Period
Changed”.

Client() //m_Client
is a reference to
the Client class in
the Client DLL.
returnval as string
returnval=m_Clien
t.SetTimeOut(clien
tiD,
desiredTimeOut)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by

another client”.

The session is UNLOCKED and the message displayed is "Lock Session to
execute the command".

The server is NOTFOUND and the message displayed is "Server not

found...Disconnect!".

When none of these fail conditions occur, then the message displayed is

"Failed...".

out string clientlD

Name Type Direction Description
clientlD string out Identifier of the client
that is connected to the
server
clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70
string time
Name Type Direction Description
time string IN The time in seconds

that refers to the
timeout period
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The time parameter gives the timeout period, which is the time the client is
allowed to be locked and idle. After the timeout period, if the client is still idle, it
gets unlocked.

The time parameter should be a positive integer. Else, the client is prompted to
provide a valid timeout period.
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Wait for the test to
complete

The commands in this group are executed while tests are running. The
GetCurrentStateInfo() and SendResponse() commands are executed when
application is running and in wait state.

Command name

Parameters

Description

Return value

Example

ApplicationStatus()

string clientlD

This method gets
the status of the
server application.
The states at a
given time are
Ready, Running,
Paused, Wait, or
Error.

String value that
gives the status of
the server
application.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL.
returnval as string
returnval=m_Clien
t.ApplicationStatu
s(clientID)

QueryStatus() string clientlD This is an interface| String that gives | m_Client = new
out string status | for the user to the status of the | Client() //m_Client
transfer Analyze | operation after it | is a reference to
panel status has been the Client class in
messages from | performed. the Client DLL.
the server to the | On success the | returnval as string
client. return value is returnVal=m_Clien
“Transferred...”. | t.QueryStatus(clie
ntID, out
statusMessages)
if
((OP_STATUS)ret
urnVal ==
OP_STATUS.SUC
CESS)
return “Status
updated...”
else
return
CommandFailed(r
eturnVal)
GetCurrentStatelnf string clientlD This method gets | This command m_Client = new
o() out string caption | the additional does not return | Client() //m_Client
_ loutstring information of the | any value. is a reference to
NOTE. This message states when the | This function fills | the Client class in
command is used | out string applicationisin | up the out the Client DLL.
when the buttonTexts Wait or Error state| parameters that | m_Client.GetCurre
application is Except client ID, | are passed when | ntStatelnfo(clientl
running and is in all the others are | invoking this D,
the wait or error out parameters. | function. caption,message,

state.

buttonTexts)
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Command name

Parameters

Description

Return value

Example

SendResponse()

command is used
when the
application is
running and is in
the wait or error
state.

NOTE. This

string clientlD
out string caption
out string
message

string response

After receiving the
additional
information using
the method
GetCurrentStatelnf
0(), the client can
decide on the
response to send
and send the
response to the
application using
this function. The
response should
be one of the
strings that was
earlier received as
a string array in
the
GetCurrentStatelnf
o function. The
_caption and
_message should
match the
information
received earlier in
the
GetCurrentStatelnf
o function.

This command
does not return
any value.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL.
m_Client.SendRes
ponse(clientID,
caption,message,
response)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by

another client".

The session is UNLOCKED and the message displayed is "Lock Session to
execute the command".

The server is NOT FOUND and the message displayed is "Server not
found...Disconnect!".

When none of these fail conditions occur, then the message displayed is

"Failed...".

Ready: Test configured and ready to start

Running: Test running

Paused: Test paused

Wait: A popup that needs your inputs

Error: An error has occurred
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Name Type Direction Description
clientlD string ouTt Identifier of the client
that is connected to the
server
clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70
out string status
Name Type Direction Description
status string array out The list of status
messages generated
during run
out string caption
Name Type Direction Description
caption string out The wait state or error
state message sent to
you
out string message
Name Type Direction Description
message string out The wait state/error
state message to you
out string buttonTexts
Name Type Direction Description
buttonTexts string array out An array of strings
containing the possible
response types that
you can send
string response
Name Type Direction Description
response string IN A string containing the

response type that you
can select (it must be
one of the strings in the
string array
buttonTexts)
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Command name

Parameters

Description

Return value

Example

GetPassFailStatu
s()

string clientlD
string device

This method gets
the pass or fail

String that gives
the status of the

m_Client = new
Client() //m_Client

string suite status of the operation afterit | is a reference to
string test measurement after| has been the Client class in
test completion. | performed. the Client DLL.
_ |Returnsthepass |returnval as string
NOTE. Execute | or fail status in the | returnval=m_Clien
this command form of a string. | t.GetPassFailStatu
after completing s(clientID, device,
the measurement. suite, "Transmitter
—_— Output Droop”) //
Pass or Fail
GetResultsValue()| string clientID This method gets | String that gives | m_Client = new
string device the result values off the status of the | Client() /m_Client
string suite the measurement | operation after it | is a reference to
string test after the run. has been the Client class in
string performed. the Client DLL.
parameterString Returns the result | returnval as srting

value in the form
of a string.

returnval=m_Clien
t.GetResultsValue(
clientlD, "BRR",
"BRR",
"Transmitter
Output Droop",
"Measured Value")
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Command name

Parameters

Description

Return value

Example

GetResultsValueF
orSubMeasureme
nts()

string clientlD
string device
string suite
string test

string
parameterString
int rowNr

This method gets
the result values
for individual sub-
measurements,
after the run.

String that gives
the status of the
operation after it
has been
performed.
Returns the result
value in the form
of a string.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL.
returnval as string
Single-ended
Low Level
Voltages DP (nS)
returnval=m_Clien
t.GetResultsValue
ForSubMeasurem
ents(clientID,
"BRR", "BRR",
"Transmitter
Output Droop”,
"Transmitter
Output Droop”,
"Measured Value",
0) /[For DP wfm
returnval=m_Clien
t.GetResultsValue
ForSubMeasurem
ents(clientID,
"BRR", "BRR",
"Transmitter
Output Droop”,
"Measured Value",
1) //For DN wfm
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Command name | Parameters Description Return value Example

GetReportParamet string clientlD This method gets | The return value is| m_Client = new

er() string device the general report | the oscilloscope | Client() //m_Client
string suite details suchas | model, is a reference to
string test oscilloscope TekExpress the Client class in
string model, version, and BRR | the Client DLL.
parameterString | TekExpress version. returnval as string

version, and BRR
version.

Oscilloscope
Model

returnval=
m_Client.GetRepo
rtParameter(client
_ld,device, suite,'
''Scope Model')
TekExpress
Version
returnval=
m_Client.GetRepo
rtParameter(client
_ld,device,suite,’
"' TekExpress
Version')

BRR Version
returnval=
m_Client.GetRepo
rtParameter(client
_ld,device,suite,’

''Application
Version')
TransferReport() | string clientlD This method String that gives | m_Client = new
string filePath transfers the the status of the | Client() //m_Client
report generated | operation afterit | is a reference to
after the run. has been the Client class in
The report performed. the Client DLL.
contains the Transfers all the | returnval as string
summary of the | result values in the| returnval=m_Clien
run. form of a string. | t.TransferReport(cl
The client must ientID,"C:\Report”)
provide the

location where the
report is to be
saved at the client-
end.
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NOTE. For each

click of Run
button, a folder is
created in the X:

Command name | Parameters Description Return value Example

TransferWaveform| string clientlD This method String that gives | m_Client = new

s() string filePath transfers all the | the status of the | Client() //m_Client
waveforms from | operation afterit | is a reference to
the folder for the | has been the Client class in
current run. performed. the Client DLL.

Transfers all the
waveforms in the
form of a string.
On success the
return value is

returnval as string
returnval=m_Clien
t.TransferWavefor
ms(clientID,"C:
\Waveforms”)

current run (for a
given suite or
measurement).

NOTE. For each

click of Run
button, a folder is
created in the X:
drive. Transfer the
waveforms before
clicking the Run
button.

drive. Transfer the| “Transferred...”.
waveforms before
clicking the Run
button.

Transferlmages() | string clientlD This method String that gives | m_Client = new

string filePath transfers all the | the status of the | Client() //m_Client

images operation after it | is a reference to
(screenshots) from| has been the Client class in
the folder for the | performed. the Client DLL.

Transfers all the
images in the form
of a string.

returnval as string
returnval=m_Clien
t.Transferimages(c
lientID, "C:

\Waveforms’)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by

another client”.

The session is UNLOCKED and the message displayed is "Lock Session to
execute the command".

The server is NOTFOUND and the message displayed is "Server not
found...Disconnect!".

When none of these fail conditions occur, then the message displayed is

"Failed...".
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out string clientiD

Name Type Direction Description

clientlD string ouTt Identifier of the client
that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

string device

Name Type Direction Description
device string IN Specifies the name of
the device
string suite
Name Type Direction Description
suite string IN Specifies the name of
the suite
string test
Name Type Direction Description
test string IN Specifies the name of
the test to obtain the
pass or fail status

string parameterString

Name Type Direction Description
parameterString string IN Selects or deselects a
test
int rowNr
Name Type Direction Description
rowNr int IN Specifies the zero

based row index of the
sub-measurement for
obtaining the result
value
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string filePath

Name

Type

Direction

Description

filePath

string

IN

The location where the
report must be saved in

the client
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session is saved

Command name | Parameters Description Return value Example
CheckSessionSav | string clientlD This method is Return valueis | m_Client = new
ed() out bool saved called when a either True or Client() //m_Client
check is to be False. is a reference to
made to know if the Client class in
the current the Client DLL.
session is saved. returnval as string
returnval=m_Clien
t.CheckSessionSa
ved(m_clientID,
out savedStatus)
RecallSession() | string clientlD Recalls a saved | String that gives | m_Client = new

string name session. The the status of the | Client() //m_Client
name of the operation after it | is a reference to
session is has been the Client class in
provided by the | performed. the Client DLL.
client. The return value is| returnval as string
“Session returnval=m_Clien
Recalled...”. t.RecallSession(cli
entlD,
savedSessionNam
e)
SaveSession() string clientlD Saves the current | String that gives | m_Client = new
string name session. The the status of the | Client() //m_Client
name of the operation after it | is a reference to
session is has been the Client class in
provided by the | performed. the Client DLL.
client. The return value is| returnval as string
"Session returnval=m_Clien
Saved..."/"Failed...| t.SaveSession(clie
ntiD,
desiredSessionNa
me)
SaveSessionAs() | string clientID Saves the current | String that gives | m_Client = new

string name

sessionin a
different name
every time this
method is called.
The name of the
session is
provided by the
client.

the status of the
operation after it
has been
performed.

The return value is
"Session
Saved...".

Client() //m_Client
is a reference to
the Client class in
the Client DLL.
returnval as string
returnval=m_Clien
t.SaveSessionAs(c
lientID,
desiredSessionNa
me)
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NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by
another client".

The session is UNLOCKED and the message displayed is "Lock Session to
execute the command".

The server is NOTFOUND and the message displayed is "Server not
found...Disconnect!".

When none of these fail conditions occur, then the message displayed is
"Failed...".

out string clientlD

Name Type Direction Description

clientlD string ouTt Identifier of the client
that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

string name

Name Type Direction Description

name string IN The name of the
session being recalled

The name parameter cannot be empty. If it is empty, the client is prompted to
provide a valid name.

string name
Name Type Direction Description
name string IN The name of the
session being saved

The name parameter cannot be empty. If it is empty, the client is prompted to
provide a valid name.

Once the session is saved under ‘name’ you cannot use this method to save the
session in a different name. Use SaveSessionAs instead.
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Unlock the server

string name
Name Type Direction Description
name string IN The name of the

session being recalled

The same session is saved under different names using this method. The name
parameter cannot be empty. If it is empty, the client is prompted to provide a

valid name.

out bool saved

Name

Type

Direction

Description

saved

bool

ouT

Boolean representing
whether the current
session is saved

This parameter is used as a check in SaveSession() and SaveSessionAs()

functions.

Command name

Parameters

Description

Return value

Example

UnlockSession()

string clientlD

This method
unlocks the server
from the client.
The ID of the client
to be unlocked
must be provided.
Note

String that gives
the status of the
operation after it
has been
performed.

The return value is
"Session Un-
Locked...".

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL.
returnval as string
returnval=m_Clien
t.UnlockServer(clie
ntiD)
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NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by
another client".

The session is UNLOCKED and the message displayed is "Lock Session to
execute the command".

The server is NOTFOUND and the message displayed is "Server not
found...Disconnect!".

When none of these fail conditions occur, then the message displayed is

"Failed...".

out string clientlD

Name Type Direction Description

clientlD string ouTt Identifier of the client

that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

NOTE. When the client is disconnected, the client is automatically unlocked.

Disconnect from the Command name | Parameters Description Return value Example

server

Disconnect()

string clientlD

This method
disconnects the
client from the

Integer value that
gives the status of
the operation after

m_Client = new
Client() //m_Client
is a reference to

serveritis it has been the Client class in
connected to. Note| performed. the Client DLL.
1 for Success returnval as string
—1 for Failure returnval=m_Clien

t.Disconnect(m_cli
entlD)
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NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by
another client".

The session is UNLOCKED and the message displayed is "Lock Session to
execute the command".

The server is NOTFOUND and the message displayed is "Server not
found...Disconnect!".

When none of these fail conditions occur, then the message displayed is
"Failed...".

out string clientlD

Name Type Direction Description

clientlD string ouTt Identifier of the client
that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

NOTE. When the client is disconnected, the client is automatically unlocked.

Handle error codes  The return value of the remote automations at the server-end is OP_ STATUS,
which is changed to a string value depending on its code and returned to the
client. The values of OP_STATUS are as follows:

Value Code Description

FAIL -1 The operation failed.
SUCCESS 1 The operation succeeded.
NOTFOUND 2 Server not found

LOCKED 3 The server is locked by another

client, so the operation cannot
be performed.

UNLOCK 4 The server is not locked. Lock
the server before performing
the operation.

NULL 0 Nothing
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NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by
another client".

The session is UNLOCKED and the message displayed is "Lock Session to
execute the command".

The server is NOTFOUND and the message displayed is "Server not
found...Disconnect!".

When none of these fail conditions occur, then the message displayed is
"Failed...".
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